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अȯाय-1 

िडिजटल DOCUMENTATION (उɄत) 

सũ 1: DOCUMENTS मŐ Styles बनाएँ और apply करŐ  
Style 

एक Style formats का एक सेट है िजसे हम अपने DOCUMENTS मŐ चयिनत पृʿो,ं text, Žेम और अɊ तȕो ंपर जʗी से 

अपना format बदलने के िलए apply कर सकते हœ।. 

 
उदाहरण: बोʒ, फ़ॉȴ का आकार: 24, फ़ॉȴ का नाम: कॉिमक सœस एमएस, रंग: लाल 

को नाम िदया जा सकता है : mystyle1 ormytext  

जब हम एक Style apply करते हœ, हम एक ही समय मŐ formats के एक पूरे समूह को apply करते हœ। 
Styles and Formatting िवंडो: 

 
Styles के Ůकार: 

• PAGE Styles मािजŊन, हेडर और फुटर, बॉडŊर और बैकŤाउंड शािमल करŐ। 
•PARAGRAPH Styles paragraph की उपİ˕ित के सभी पहलुओ ंको िनयंिũत करŐ , जैसे text alignment, टैब ːॉप, लाइन 

˙ेिसंग और बॉडŊर, और character formatting शािमल कर सकते हœ। 
•CHARACTER Styles paragraph के भीतर चयिनत text को Ůभािवत करता है, जैसे िक text का फ़ॉȴ और आकार, या 
बोʒ और इटैिलक format। 
•Frame Styles wrapping type, बॉडŊर, बैकŤाउंड और कॉलम सिहत Ťािफक और टेƜ ůेम को फॉमőट करने के िलए 

उपयोग िकया जाता है। 
•Numbering Styles Ţमांिकत या बुलेटेड सूिचयो ंमŐ समान alignment, Ţमांकन या बुलेट वणŊ और फ़ॉȴ apply करŐ। 
•Cell Styles फोटं, alignment, बॉडŊर, background, संƥा Ůाŝप (उदाहरण के िलए, मुūा, िदनांक, संƥा), और सेल सुरƗा 
शािमल करŐ। 
•Graphics Styles रेखािचũो ंऔर presentations मŐ रेखा, Ɨेũ, छायांकन, पारदिशŊता, फ़ॉȴ, कनेƃर, आयाम और अɊ 

िवशेषताएँ शािमल हœ। 
•Presentation Styles फ़ॉȴ, इंडŐट, įरİƅ, alignment और टैब के िलए िवशेषताएँ शािमल करŐ। 



Style apply करŐ  
Styles and Formatting िवंडो का उपयोग करके Styles को apply करने के चरण 

1. ːाइल और फॉमőिटंग िवंडो को ओपन करŐ  F11 Key को दबाकर। 
2. उस text का चयन करŐ  जहाँ हम Style apply करना चाहते हœ। 
3. Styles and Formatting िवंडो से Style का चयन करŐ। 
 
Ůाŝप मोड भरŐ   
Styles और formatting िवंडो पर वापस जाने और हर बार डबल-İƑक िकए िबना कई अलग-अलग Ɨेũो ंमŐ Style को जʗी 
से apply करने के िलए उपयोग िकया जाता है। यह िविध काफी उपयोगी है जब हमŐ एक ही Style के साथ कई िबखरे Šए 

paragraphs, कƗो ंया अɊ वˑुओ ंको ˢŝिपत करने की आवʴकता होती है। 
 

Fill format mode का उपयोग करके Style को apply करने के चरण 

1. Styles and Formatting िवंडो खोलŐ और उस Style का चयन करŐ  िजसे हम apply करना चाहते हœ। 
2. िफल फ़ॉमŔट मोड आइकन पर İƑक करŐ। 
3. अब उस टेƜ को चुनŐ (İƑक करŐ  और खीचंŐ) जहां हम उस Style को apply करना चाहते हœ। 
िटɔणी:-िफल फॉमŔट मोड से बाहर िनकलने के िलए, िफल फॉमőट मोड आइकन पर िफर से İƑक करŐ  या Esc Key दबाएं। 

एक नया Style बनाना 
चयन से नया Style बनाने के चरण 

1. Styles and Formatting िवंडो खोलŐ और उस Style का चयन करŐ  िजसे हम बनाना चाहते हœ। 
2. हम चाहŐ तो कुछ बदलाव करŐ। 
3. उस text का चयन करŐ  िजसे हम Style के ŝप मŐ सहेजना चाहते हœ। 
4. Styles and Formatting िवंडो मŐ, चयन से नया Style आइकन पर İƑक करŐ। 
5. Style बनाएँ dialog मŐ, नया Style के िलए एक नाम टाइप करŐ। ओके पर İƑक करŐ। 

डŌ ै िगंग एंड डŌ ॉिपंग Ȫारा नया Style बनाने के चरण 

1. कुछ text का चयन करŐ  और इसे Styles and Formatting िवंडो मŐ खीचंŐ। 
 

Styles को संशोिधत करना 
चयन से Style को अपडेट करने के चरण 

1. Styles and Formatting िवंडो खोलŐ. 
2. paragraph, सूची या वणŊ का चयन करŐ  िजसमŐ वह Ůाŝप है िजसे हम Style के ŝप मŐ चाहते हœ। 
3. Styles and Formatting िवंडो मŐ, उस Style का चयन करŐ  िजसे हम update करना चाहते हœ। 
4. Ɋू ːाइल ůॉम िसलेƕन आइकन के आगे तीर पर लंबे समय तक İƑक करŐ  और अपडेट ːाइल पर İƑक करŐ। 

 
 
 

 
 



िकसी अɊ DOCUMENTS या टेɼलेट से Styles को लोड या कॉपी करने के चरण 

1. वह DOCUMENTS खोलŐ जहाँ से हम Styles की copy बनाना चाहते हœ। 
2. Styles and Formatting िवंडो मŐ, New Style from Selection icon  के बगल मŐ तीर पर लंबे समय तक İƑक करŐ  , और 

िफर Load Styles पर İƑक करŐ। 
3. Load Styles dialog बॉƛ पर, Styles की ŵेिणयो ंमŐ से टेɼलेट का चयन करŐ। 
4. ओके बटन पर İƑक करŐ। 
नोट: अɊ DOCUMENTS से Styles को कॉपी करने के िलए, From File बटन İƑक करŐ  एक िवंडो खोलने के िलए, िजससे 

हम आवʴक DOCUMENTS का चयन कर सकते हœ। 
 
महȕपूणŊ िबंदु: 

⮚  ओपन ऑिफस राइटर मŐ Style और formatting  िवंडो खोलने के िलए  F11 दबाएं  

⮚  नया Style बनाने के िलए Shift+F11 दबाएं 

⮚  हम Style को टेɼलेट या िकसी अɊ DOCUMENTS से लोड करके कॉपी कर सकते हœ। 
⮚  िकसी Style मŐ हमारे Ȫारा िकया गया कोई भी पįरवतŊन केवल वतŊमान DOCUMENTS मŐ Ůभावी होता है। 
⮚  हम नया Style बनाने के िलए टेƜ चयन को ːाइल और फ़ॉमőिटंग िवंडो मŐ डŌ ैग और डŌ ॉप कर सकते हœ। 
 
बŠिवकʙीय Ůʲ योƶता आधाįरत Ůʲ (केस आधाįरत/ŷोत आधाįरत) 

Q1. मीनाƗी एक िकताब िलख रही है। वह पूरे DOCUMENTS मŐ समान formatting चाहती है। उदाहरण के िलए: सभी 
अȯाय का नाम, शीषŊक, िचũ का नाम एक ही Ůाŝप (format) मŐ होना चािहए। यिद वह ओपन ऑिफस राइटर मŐ पुˑक 

िलख रही है, तो उसके िलए कौन-सा िवकʙ सबसे उपयुƅ है? 
1. Template  
2. Styles 
3. Mail Merge 
4. Table of Index 

 

Q2. अनुराग दसवी ंकƗा मŐ है। उसके पास ओपनऑिफस राइटर मŐ एक दˑावेज है। वह Style और formatting िवंडो पर 

वापस जाने और हर बार डबल-İƑक िकए िबना DOCUMENTS के कई अलग-अलग Ɨेũो ंमŐ Style को जʗी से apply 

करना चाहता है। उसे एक ही Style के साथ कई िबखरे Šए paragraphs, cells या अɊ वˑुओ ंको format करने की 
आवʴकता है। इस İ˕ित मŐ Style को apply करने का सही िवकʙ Ɛा होगा? 

1. िफल फॉमőट मोड 
2. style from a selection 

3. कॉपी Style कीबोडŊ शॉटŊकट का उपयोग कर 

4. text selection Styles और फ़ॉमőिटंग िवंडो मŐ drag and drop कर 

 
उȞेʴ आधाįरत Ůʲ 

Q1 .िलŰे ऑिफस राइटर मŐ िनɻिलİखत मŐ से कौन सा Style बोʒ, इटैिलक और फॉȴ साइज जैसे format को Ůभािवत 

करता है? 

1. Paragraph styles 3. Character styles 

2. Graphics styles  4. Page styles 

 

Q2. िलŰे ऑिफस राइटर मŐ ːाइʤ और िवंडो को फॉमőट करने के िलए िनɻ मŐ से कौन सी कीबोडŊ शॉटŊकट की सही है? 

1. F9   3. F10 



2. F11   4. F12 

 

Q3 कौन सा नया ːाइल बनाने का सही तरीका है 

1. फ़ाइल मैɊू से 

2. चयन से 

3. डŌ ॉइंग टूलबार से 

4. कीबोडŊ शॉटŊकट F9 से 
 

Q4. ओपन ऑिफस राइटर मŐ ːाइल कॉपी करने का सही तरीका Ɛा है? 

1. एक अɊ DOCUMENTS 

2. एक टेɼलेट से लोड 

3. ऊपर के दोनो ंसही तरीके है 

4. ऊपर के दोनो ं गलत तरीके है 
 

Q5. नंबįरंग Styles समान ___________ apply करŐ  
1. बुलेटेड सूिचयाँ 
2. background 
3. headers and footers 

4. बोʒ और इटैिलक formats 
 

वणŊनाȏक Ůʲ (SAQs और LAQs) 

लघु उȅरीय Ůकार के Ůʲ (2 अंक) 

Q1। ओपनऑिफस राइटर मŐ Styles Ɛा हœ? 

Q2.ओपनऑिफ़स राइटर मŐ िकɎी ंदो Ůकार के Style के नाम बताएँ। 
Q3.ओपनऑिफस राइटर मŐ ːाइल और िवंडोज़ को फॉमőट करने के कोई दो तरीके िलİखए। 
Q4.ओपनऑिफ़स राइटर Styles को संशोिधत करने की अनुमित देता है। मौजूदा Style को update करने के कोई दो तरीके 

िलİखए। 
 
दीघŊ उȅरीय Ůकार के Ůʲ (4 अंक) 

Q1. चयन से Style को अपडेट करने के चरण। 
Q2. ओपनऑिफस राइटर मŐ ːाइल apply करने के िलए िफल फॉमőट मोड Ɛा होता है? कदम िलİखए। 
Q3. Ɛा हम अपनी खुद का कːम ːाइल बना सकते हœ? अगर हाँ Steps िलखो । 
Q4. ओपनऑिफस राइटर मŐ Styles Ɛा हœ? िकɎी ंचार Styles के नाम िलİखए। 
 
  



सũ 2. छिवयो ंको सİʃिलत करŐ  और उनका उपयोग करŐ  
DOCUMENTS मŐ छिवयां जोड़Ő/डालŐ 

1. डŌ ैग एंड डŌ ॉप: िवंडो से इमेज चुनŐ-> राइटर मŐ डŌ ैग करŐ  िफर डŌ ॉप करŐ। 
2. İƑपबोडŊ से एक छिव सİʃिलत करना: कॉपी (Ctrl+C) और पेː (Ctrl+V) का उपयोग करना 
3. िपƁर डायलॉग डालŐ: INSERT>PICTURE> मैɊू बार से फाइल से। 
4. एक ˋैनर का उपयोग करके एक छिव सİʃिलत करना: INSERT>PICTURE>SCAN>Source का चयन करŐ। 
5. गैलरी से एक छिव सİʃिलत करना: टूʤ > गैलरी या पर İƑक करŐपर İƑक करŐ गेलरी आइकन मानक टूलबार 

पर। 
 
छिव संशोिधत करŐ  
िपƁर टूलबार का उपयोग करना 
हम िचũ टूलबार का उपयोग करके एक छिव को संशोिधत कर सकते हœ (देखŐ> टूलबार> िचũ) 

Ťािफक िफʐर और उनके Ůभाव 

औधंाना : रंग छिव के रंग मान या Ťेˋेल छिव के चमक मान को उलटा करता है। 

िचकना : छिव के कंटŌ ाː को नरम करता है। 

पैना : छिव के कंटŌ ाː को बढ़ाता है। 

शोर दूर करो  : छिव से एकल िपƛेल िनकालता है। 

पारदिशŊता  : 

 
हम कर सकते हœ संशोिधत छिव को अिधक पारदशŎ बनाने के िलए िपƁर टूलबार पर पारदिशŊता बॉƛ मŐ Ůितशत मान। 
वॉटरमाकŊ  बनाते समय या पृʿभूिम मŐ छिव लपेटते समय यह िवशेष ŝप से उपयोगी होता है। 
 
फ़ॉमőिटंग टूलबार और िपƁर डायलॉग का उपयोग करना 
कोिचũ खोलŐ टूलबार छिव पर राइट-İƑक करके और िचũ का चयन करŐ। 
हम Style और रंग का चयन करके छिव के चारो ंओर एक सीमा बना सकते हœ, या हम छिव मŐ एक छाया जोड़ सकते हœ। 
 

Ţॉिपंग छिवयां: 
Ţॉप करके हम इमेज के दोनो ंओर (बाएं, दाएं, ऊपर, नीचे) Ţॉप (कट ऑफ) कर सकते हœ। 
कबपैमाना रखोचयिनत है (िडफ़ॉʐ), छिव को Ţॉप करने से िचũ का पैमाना नही ंबदलता है। 
कबछिव रखोआकार का चयन िकया जाता है, तो छिव के शेष भाग को बड़ा या छोटा कर िदया जाता है तािक छिव की चौड़ाई 

और ऊंचाई अपįरवितŊत रहे। 
 
एक छिव का आकार बदलना 
छिव का चयन करŐ , इसके चारो ंओर हरे रंग के आठ हœडल मŐ से िकसी एक पर İƑक करŐ  और इसे इसके नए आकार मŐ 
खीचंŐ। 
कोने के हœडल Ťािफ़क ऑɥेƃ की चौड़ाई और ऊंचाई दोनो ंका एक साथ आकार बदलते हœ, जबिक अɊ चार हœडल एक 

समय मŐ केवल एक आयाम का आकार बदलते हœ। 
Ťािफक के मूल अनुपात को बनाए रखने के िलए,िशɝ + İƑक करŐएक कोने का हœडल, िफर खीचंŐ। 
 



 
िचũ को घुमाना 
िकसी िचũ को घुमाने के िलए लेखक कोई सीधा उपकरण Ůदान नही ंकरता है। पर हम यह कर सकते हœ एक िचũ घुमाएँ 

OpenOffice Draw या Impress मŐ िफर उस तˢीर को वापस कॉपी करŐ लेखक को. 
 
डŌ ाइंग टूलबार 

डŌ ॉइंग टूल का उपयोग शुŝ करने के िलए, ʩू > टूलबार > डŌ ॉइंग पर İƑक करके डŌ ॉइंग टूलबार ŮदिशŊत करŐ। 
 
आरेखण वˑु का आकार बदलना 
ऑɥेƃ का चयन करŐ , उसके चारो ंओर आठ हœडल मŐ से िकसी एक पर İƑक करŐ  और उसे उसके नए ˕ान पर खीचंŐ। 
या 
1 format > वˑु > İ˕ित और आकार चुनŐ। 
2 चौड़ाई और ऊंचाई को ˢतंũ ŝप से सेट करने के िलए İ˕ित और आकार dialog बॉƛ का उपयोग करŐ। 
नोट :- यिदअनुपात रखŐ िवकʙ चुना जाता है, तो ऊँचाई और चौड़ाई बदल जाती है तािक अनुपात बना रहे। 
डŌ ॉइंग ऑɥेƃ्स को Ťुप करना: सभी वˑुओ ंका चयन करŐ , िफर format> समूह> समूह 

 

टेƜ के अंदर पोिजशिनंग इमेज/Ťािफƛ 

जब हम िकसी टेƜ डॉƐूमŐट मŐ Ťािफक जोड़ते हœ, तो हमŐ यह चुनने की आवʴकता होती है िक टेƜ और अɊ Ťािफƛ 

के संबंध मŐ इसे कैसे रखा जाए। 
िकसी Ťािफ़क की İ˕ित िनधाŊरण को चार तरीको ंसे िनयंिũत िकया जाता है: 

1. ʩव˕ा यह िनयंिũत करता है िक Ťािफƛ को सामने कैसे रखा जाए यापीछे text या अɊ Ťािफƛ। 
2. alignment बाएँ, दाएँ, कŐ ū, औिचȑ, ऊपर, नीचे लंगर िबंदु के िलए। 
3. एंकįरंग पृʿ, ůेम, पैराŤाफ, या एक character जैसे Ťािफƛ के संदभŊ िबंदु को संदिभŊत करता है। 
4. text रैिपंग आसपास के text के िलए Ťािफƛ के संबंध को संदिभŊत करता है, जो Ťािफक को एक या दोनो ंतरफ लपेट 

सकता है, Ťािफक के पीछे या सामने ओवरिŮंट िकया जा सकता है। 
 
इन सेिटंƺ को िविभɄ तरीको ंसे apply िकया जा सकता है: - 

1. Ůाŝप मैɊू 

2. Ťािफƛ पर राइट İƑक करŐ  
3. ऑɥेƃ टूलबार 

4. िचũ dialog बॉƛ, 

5. İ˕ित और आकार dialog बॉƛ 

 
 
 
 
 
 
 
 
 
 



बŠिवकʙीय Ůʲ योƶता आधाįरत Ůʲ (केस आधाįरत/ŷोत आधाįरत) 

Q1। अनु एक documents मŐ कुछ तˢीरŐ  जोड़ना चाहती है। उसे नीचे की तरह एक İखड़की वाली दीवार की तˢीर िमलती 
है। वह िचũ का केवल İखड़की वाला भाग चाहती है। िचũ के अितįरƅ भागो ंको हटाने के िलए वह राइटर मŐ िकस option 
का उपयोग कर सकती है? 

   
1. Style 
2. opCr  
3. खाका 
4. िफ़ʐर 

 

Q2 अनु एक DOCUMENTS मŐ एक िचũ सİʃिलत करती है। पैराŤाफ टेƜ तˢीर के ऊपर और नीचे आता है। वह चारो ं
ओर text करना चाहती हैिचũ .कौन िवकʙ Ɛा वह राइटर मŐ Ůयोग करŐ? 

    
1. text रैिपंग 

2. टेƜ एंकįरंग 
3. text alignment 

4. text ʩव˕ा 
 

Q3. आशा कुछ आकृितयाँ सİʃिलत करना चाहती है और Ůतीको ंउसके DOCUMENTS मŐआरेखण का उपयोग करना 
टूलबार। लेिकन उɎŐ राइटर मŐ कही ंनही ंिमला। कौन सा तरीका सही है रेखांकन िदखाओ टूलबार? 

1. सİʃिलत करŐ  -> आरेखण 

2. सİʃिलत करŐ  -> टूलबार -> आरेखण 

3. देखŐ -> डŌ ाइंग टूलबार 

4. देखŐ -> टूलबार -> आरेखण 
 

उȞेʴ आधाįरत Ůʲ 

Q1. नकल करते समय छिव डŌ ैग का उपयोग करना और डŌ ॉप मेथड ________ कीज़ को होʒ डाउन करŐ  एक िलंक बनाएँ 

ŷोत से छिव फ़ाइल। 
1. CTRL + िशɝ 
2. CTRL + Alt 

3. सीटीआरएल 

4. बदलाव 
 

Q2. गैलरी से छिवयां सİʃिलत करने के िलए, गैलरी आइकन/मŐ उपलɩ िवकʙ 



1. उपकरण मैɊू केवल 

2. केवल मानक टूलबार 

3. टूल मैɊू और œːडडŊ टूलबार दोनो ंपर 

4. केवल मैɊू डालŐ 
 

Q 3.  जबिक Ťािफक के मूल अनुपात को बनाए रखने के िलएछिव का आकार बदलना _______ होʒ करŐ , िफर िकसी एक 

कोने के हœडल पर İƑक करŐ  िफर डŌ ैग करŐ। 
1. सीटीआरएल 

2. छान-बीन करना 
3. CTRL + िशɝ 

4. सब कुछ 
 

Q4. के िलए कौन सा िवकʙ सबसे अǅा है िचũ बनाना वाटर-माकŊ  एक ओपनऑिफस मŐ लेखक DOCUMENTS? 

1. काटना 
2. आकार 

3. पैना 
4. पारदिशŊता 

 

Q5. कौन सा Ťािफक िफ़ʐर उपलɩ नही ंहैओपनऑिफस मŐ लेखक िचũ टूलबार? 

1. पारदिशŊता 
2. शोर दूर करो 
3. पृʿभूिम िनकालŐ 
4. औधंाना 

 
वणŊनाȏक Ůʲ (SAQs और LAQs) 

लघु उȅरीय Ůकार के Ůʲ 

Q1. पोिजशिनंग Ťािफƛ से संबंिधत िकɎी ंदो टेƜ रैिपंग िवकʙो ंके नाम बताएं। 
Q2. Ɛा हम घुमा सकते हœ िचũो ंलेखक मŐ, यिद हाँ/नही ंतो कैसे? 

Q3. ओपन ऑिफस राइटर मŐ डŌ ॉइंग ऑɥेƃ्स को कैसे समूिहत करŐ? 

Q4. इमेज डालने के िलए ːेɛ िलखŐˋैनर से. 

 
दीघŊ उȅरीय Ůकार के Ůʲ 

Q1. ओपनऑिफस राइटर मŐ इमेज डालने के िलए िकɎी ंचार अलग-अलग तरीको/ंŷोतो ंके नाम बताएं। 
Q2. िकɎी ंचार Ťािफक के नाम िलİखए िफʐर हम OpenOffice Writer मŐ छिवयो ंको संशोिधत करने के िलए उपयोग कर 

सकते हœ। 
Q3. जŝरत पड़ने पर हम टेƜ मŐ इमेज/Ťािफƛ की पॉिज़शन बदल सकते हœ। İ˕ित बदलने के चार अलग-अलग तरीके 

हœ। उɎŐ 1 या 2 मŐ समझाइएपंİƅयां Ůȑेक। 
Q4. रैिपंग, एंकįरंग, एलाइनमŐट, अरŐजमŐट िवकʙ का उपयोग करके छिवयो ंकी İ˕ित बदलने के िकɎी ं4 तरीको ंके नाम 

बताएं। 



 

सũ 3: टेɼलेट बनाएं और उसका उपयोग करŐ  
एक टेɼलेट एक मॉडल है िजसका उपयोग हम अɊ DOCUMENTS बनाने के िलए करते हœ। उदाहरण के िलए, हम 

ʩावसाियक įरपोटŊ के िलए एक टे̱ɘेट बना सकते हœ िजसके पहले पृʿ पर हमारी कंपनी का लोगो हो। इस टे̱ɘेट से बनाए 

गए नए दˑावेज़ो ंमŐ पहले पृʿ पर हमारी कंपनी का लोगो होगा। 
टे̱ɘेट मŐ कुछ भी हो सकता है जो िनयिमत दˑावेज़ो ंमŐ हो सकता है, जैसे text, Ťािफƛ, Styles का एक सेट, और 

उपयोगकताŊ-िविशʼ सेटअप जानकारी जैसे माप इकाइयाँ, भाषा, िडफ़ॉʐ िŮंटर और टूलबार। 
हमारे अपने टे̱ɘेट बनाने के दो तरीके: 

1. एक DOCUMENTS से, और 

2. एक जादूगर का उपयोग करना। 
DOCUMENTS से टेɼलेट बनाने के चरण 

1. उस Ůकार का एक नया या मौजूदा DOCUMENTS खोलŐ िजसे आप टेɼलेट मŐ बनाना चाहते हœ 
2. अपनी इİǅत सामŤी और Styles जोड़Ő। 
3. मुƥ मैɊू से, फ़ाइल > टे̱ɘेट > सहेजŐ चुनŐ। 

िवज़ाडŊ  का उपयोग करके टेɼलेट बनाने के चरण 

1. मुƥ मैɊू से, फ़ाइल > िवजाड्Ŋस > [टे̱ɘेट का Ůकार आवʴक] चुनŐ 
2. िवज़ाडŊ के पृʿो ंपर िदए गए िनदőशो ंका पालन करŐ। 
3. टेɼलेट को सहेजने के िलए नाम और ˕ान िनिदŊʼ करŐ। 

 

टेɼलेट का उपयोग करना 
1. फ़ाइल > नया > टे̱ɘेट और DOCUMENTS चुनŐ। 
2. हमŐ जो टे̱ɘेट चािहए, उसे चुनŐ। 
3. टे̱ɘेट पर डबल-İƑक करŐ  या इसे खोलने के िलए ओपन पर İƑक करŐ। 

 
कːम टे̱ɘेट को िडफ़ॉʐ के ŝप मŐ सेट करने के िलए: 

मुƥ मैɊू बार से, चुनŐ 
1. फ़ाइल> टे̱ɘेट> ʩवİ˕त करŐ। और िडफ़ॉʐ टेɼलेट के ŝप मŐ सेट करŐ  चुनŐ। 
2. DOCUMENTS Ůकार के िलए ओपन ऑिफ़स के िडफ़ॉʐ टेɼलेट को िडफ़ॉʐ के ŝप मŐ पुन: सƗम करने के 

िलए, िडफ़ॉʐ टेɼलेट रीसेट करŐ  चुनŐ 
3. िकसी िवशेष टे̱ɘेट का उपयोग करने के िलए, फ़ाइल > नया > टे̱ɘेट और DOCUMENTS चुनŐ। 

 

बŠिवकʙीय Ůʲ योƶता आधाįरत Ůʲ (केस आधाįरत/ŷोत आधाįरत) 

Q1. सुरिƗत जाता है उसकी तैयारी करो आय Ůमाण पũ नोटरी को कायाŊलय। वह अपना िववरण जैसे नाम, िपता का नाम, 

पता, वािषŊक आय आिद देता है।कंɗूटर के िलए ऑपरेटर। कंɗूटर ऑपरेटर िŮंट उसका आय Ůमाण पũएक सेकंड के 

भीतर. वह िकस िवकʙ का उपयोग कर सकता हैइसके िलए. 
1. Style 

2. मेल मजŊ करŐ  
3. खाका 
4. सूचकांक की तािलका 

 



Q2. सोनू अɘाई कर रहा है एक नौकरी के िलए. उस के िलए एक िफर से शुŝ बनाने की जŝरत है इसके िलए आवेदन कर 

रहे हœ काम। लेिकन वह बनाना नही ंजानता एक िफर से शुŝ। कौन ओपनऑिफस लेखक मŐ िवकʙ उसे मदद करे गाįरǛूमे 

बनाना? 
1. Style 

2. मेल मजŊ करŐ  
3. खाका 
4. सूचकांक की तािलका 

 
उȞेʴ आधाįरत Ůʲ 

Q1. के िलए एक नया बनाना टेɼलेट, टेɼलेट िवकʙ ओपनऑिफस राइटर मŐ _______ मैɊू मŐ उपलɩ है। 
1. फ़ाइल 

2. संपादन करना 
3. डालना 
4. औजार 

 

Q2. टेɼलेट Ůबंधन dialog बॉƛ खोलने का सही तरीका: 
1. फ़ाइल->नया-> टे̱ɘेट->Ůबंधन 

2. फ़ाइल-> नया -> टे̱ɘेट-> ʩवİ˕त करŐ  
3. फ़ाइल-> टे̱ɘेट -> Ůबंधन 

4. फ़ाइल-> टे̱ɘेट-> ʩवİ˕त करŐ  
 

Q3. अपना ˢयं का कːम टे̱ɘेट बनाते समय, हम अपने टे̱ɘेट DOCUMENTS मŐ _______ जोड़ सकते हœ। 
1. text और छिव/िचũ केवल 

2. टेबल और Ťािफƛ केवल 

3. text और Style केवल 

4. text, छिव, तािलका, Ťािफƛ और Style 
 

वणŊनाȏक Ůʲ (SAQs और LAQs) 

लघु उȅरीय Ůकार के Ůʲ 

Q1. ऐसे कोई दो उदाहरण िलİखए जहाँ हम टŐपलेट का उपयोग कर सकते हœ और अपने Ůयास और समय की बचत कर 

सकते हœ। 
Q2. ओपनऑिफस राइटर मŐ अपने ˢयं के टे̱ɘेट बनाने के दो तरीके Ɛा हœ? 

Q3. कैसे करŐ  बनाएं ओपनऑिफस राइटर मŐ एक DOCUMENTS का उपयोग करने वाला एक टेɼलेट? 

Q4. कैसे करŐ  रीसेट िडफ़ॉʐ ओपनऑिफस राइटर मŐ टेɼलेट? 

 
दीघŊ उȅरीय Ůकार के Ůʲ 

Q1। Ɛा एक खाका है? आदर सिहत समझाइए ओपनऑिफस के िलए लेखक। एक उदाहरण दीिजए िजसका Ůयोग करके 

हम समय की बचत कर सकते हœ खाके. 

Q2। िवज़ाडŊ का उपयोग करके टेɼलेट बनाने के चरण िलİखए। 
Q3। कːम टेɼलेट को िडफ़ॉʐ के ŝप मŐ सेट करने के चरण िलखŐ। 
  



सũ 4: सामŤी की तािलका बनाएँ और अनुकूिलत करŐ  
सामŤी सुिवधा की तािलका अनुमित देता है हमŐ बनाना है हमारे DOCUMENTS मŐ शीषŊको ंसे सामŤी की एक ˢचािलत 

तािलका। 
उदाहरण के िलए, हम अȯाय शीषŊको ंके िलए शीषŊक 1 Style और अȯाय उपशीषŊको ंके िलए शीषŊक 2 और शीषŊक 3 

Styles का उपयोग कर सकते हœ। 
 
सामŤी तािलका बनाने के चरण 

1. बनाएं शीषŊक और उपशीषŊक DOCUMENTS मŐ Styles का ठीक से उपयोग करना। 
2. सİʃिलत करŐ  > अनुŢमिणका और तािलकाएँ > अनुŢमिणका और तािलकाएँ चुनŐ। 
3. ओके पर İƑक करŐ। 

 
सामŤी की तािलका को अȨतन करने के चरण:- 

1. सामŤी की तािलका के भीतर कसŊर रखŐ। 
2. राइट-İƑक करŐ  और चुनŐ इंडेƛ/टेबल अपडेट करŐ  पॉप-अप मैɊू से। 

 
सामŤी तािलका को हटाने के चरण:- 

1. सामŤी की तािलका के भीतर कसŊर रखŐ। 
2. राइट-İƑक करŐ  और चुनŐ इंडेƛ/टेबल हटाएं पॉप-अप मैɊू से। 

 
सामŤी की तािलका को संपािदत करने के चरण:- 

1. सामŤी की तािलका के भीतर कसŊर रखŐ। 
2. राइट-İƑक करŐ  और चुनŐ इंडेƛ/टेबल संपािदत करŐ  पॉप-अप मैɊू से 

 
इंडेƛ/टेबल टैब का उपयोग करके, हम कर 

सकते हœ 

 

 
 
 

1. एक शीषŊक जोड़ना। 
2. मैɊुअल पįरवतŊन के İखलाफ सुरƗा। 
3. ˑरो ंकी अिधकतम संƥा को बदलना। 
4. कːम Styles असाइन करना।

 
 
 
 
 
 
 

 
 
 
 
 
 
 



Ůिविʼयाँ टैब का उपयोग करके, हम कर सकते हœ 

 

 

सूचकांक की संरचना रेखा बदलŐ: 
1. और#बटन का Ůितिनिधȕ करता है अȯाय संƥा. 
2. और बटन का Ůितिनिधȕ करता है Ůवेश text. 

3. टी बटन एक का Ůितिनिधȕ करता है टैब का िवŵाम ˕ान. 

4. # बटन का Ůितिनिधȕ करता हैपृʿ संƥा. 
5. रास बटन का Ůितिनिधȕ करता है हाइपरिलंक की शुŜआत. 

6. बटन का Ůितिनिधȕ करता है एक हाइपरिलंक का अंत.

 
ːाइʤ टैब का उपयोग करके, हम कर सकते हœ 

 
सामŤी तािलका मŐ paragraph Styles apply करŐ। आप तािलका के Ůȑेक बा˨रेखा ˑर पर िभɄ paragraph Style apply 

कर सकते हœ। 
 

कॉलम टैब का उपयोग करके, हम कर सकते हœ 
इंडेƛ टेबल के िलए कॉलम की संƥा (1,2 या 3) बदलŐ 

 
 

पृʿभूिम टैब का उपयोग करके, हम कर सकते हœ 
तािलका पृʿभूिम मŐ रंग या Ťािफ़क जोड़Ő। 

 



बŠिवकʙीय Ůʲ योƶता आधाįरत Ůʲ (केस आधाįरत/ŷोत आधाįरत) 

Q1. अŜण दसवी ंकƗा का छाũ है। वह ओपनऑिफस राइटर मŐ इंडेƛ बनाता है तािलका का उपयोग करना सामŤी िवकʙ 

का। वह उस इंडेƛ मŐ कुछ बदलाव करना चाहता है लेिकन उलझन मŐ है. उȅर देकर उसकी सहायता करŐ  जो करने के िलए 

सही िवकʙ होगा: 
1. इंडेƛ पर एक िलंक बनाएं तािक जब िवषय के नाम पर İƑक करŐ , तो सीधे उस िवषय पृʿ पर जाएं 

2. अȨतन करने के िलए पįरवतŊन िनिमŊत सूचकांक मŐ. 
3. हाइपरिलंक 

4. अपडेट पर राइट İƑक करŐ  
 

Q2. आशा दसवी ंकƗा की छाũा है। वह कोिशश कर रही है एक बनाएं ओपनऑिफस राइटर मŐ इंडेƛतािलका का उपयोग 

करना सामŤी िवकʙ का। Ůिविʼयो ंटैब मŐ, जबिक संरचना रेखा वह űिमत है उȞेʴ के बारे मŐ के िविभɄ बटन. इन बटनो ं
का अथŊ पहचानने मŐ उसकी मदद करŐ। 

 
1. E# बटन __________ का Ůितिनिधȕ करता है। 
2. E बटन __________ का Ůितिनिधȕ करता है। 
3. T बटन एक __________ का Ůितिनिधȕ करता है। 
4. # बटन __________ का Ůितिनिधȕ करता है। 
5. एलएस बटन __________ का Ůितिनिधȕ करता है। 
6. LE बटन _________________ का Ůितिनिधȕ करता है। 

 

उȞेʴ आधाįरत Ůʲ 

Q1.द ओपनऑिफस लेखक ________ सुिवधा अनुमित देता है हमŐ बनाना है हमारे DOCUMENTS मŐ शीषŊको ंसे एक 

ˢचािलत अनुŢमिणका। 
1. िवषयसूची 
2. सूची की तािलका 
3. सामŤी का सूचकांक 

4. शीषŊको ंका सूचकांक 
 

Q2.ओपनऑिफस मŐ राइटर टेबल ऑफ कॉȴŐट फीचर िडफ़ॉʐ ŝप से शीषŊको ंके ______ ˑरो ंका मूʞांकन करता है। 
1. 5 
2. 12 
3. 7 
4. 10 



CHAPTER 2 

ELECTRONIC SPREADSHEET (ADVANCED) 

SESSION 1: ANALYZE DATA USING SCENARIOS AND GOAL SEEK 

सũ 1: पįर̊ʴो ंऔर लƙ खोज का उपयोग करके डेटा का िवʶेषण करŐ  
 

Consolidating data (डेटा को समेिकत करना) 
डेटा> समेकन डेटा पर कई कायŘ (जैसे योग या औसत) मŐ से एक को चलाते समय दो या अिधक ŵेिणयो ंके डेटा को एक नई 

ŵेणी मŐ संयोिजत करने का एक तरीका Ůदान करता है। समेकन के दौरान, कई शीट्स से cells की सामŤी को एक ˕ान पर 

जोड़ा जा सकता है। 
Steps: 

1. OpenOffice मŐ एक नई या मौजूदा spreadsheet खोलŐ।  
2. उस सेल का चयन करŐ  जहां आप समेिकत डेटा िदखाना चाहते हœ।  
3. Menu बार से Data > consolidate(कंसोिलडेट) पर İƑक करŐ ।  
4. समेिकत संवाद बॉƛ मŐ, उन कƗो ंया शीटो ंकी ŵेणी का चयन करŐ  िजɎŐ आप समेिकत करना चाहते हœ।  
5. वह फ़ंƕन चुनŐ िजसे आप डेटा को समेिकत करने के िलए सबटोटल करना चाहते हœ (जैसे योग या औसत)  

6. कोई भी अितįरƅ सेिटंग िनिदŊʼ करŐ , जैसे िक लेबल शािमल करना है या खाली सेल।  
7. डेटा को समेिकत करने के िलए ok İƑक करŐ । 

 

Advantages(फ़ायदा):  
यह कई फाइलो ंया शीट्स मŐ फैले डेटा के साथ काम करने मŐ मदद करता है और उȋादकता, सटीकता और िनणŊय लेने की 
Ɨमताओ ंको बढ़ाता है। 
 

Creating Subtotals (सबटोटल बनाना): 
OpenOffice इलेƃŌ ॉिनक ˚ेडशीट मŐ सबटोटल एक ऐसे फ़ंƕन को संदिभŊत करता है जो िकसी सूची या तािलका के भीतर 

मानो ंकी ŵेणी के सबटोटल की गणना करता है। इस फ़ंƕन का उपयोग ŵेणी या समूह Ȫारा डेटा को सारांिशत करने के 

िलए िकया जा सकता है, िजससे आप Ůȑेक समूह के िलए कुल योग को तुरंत देख सकते हœ। 
Steps:  

1. OpenOffice मŐ एक नई या मौजूदा ˚ेडशीट खोलŐ।  
2. उस डेटा की ŵेणी का चयन करŐ  िजसे आप घटाना चाहते हœ। 
3. मेɊू बार से Data > subtotal पर İƑक करŐ।  
4. सबटोटल डायलॉग बॉƛ मŐ, उस कॉलम का चयन करŐ  िजसके आधार पर आप समूह बनाना चाहते हœ और िजस 

फ़ंƕन का आप उपयोग करना चाहते हœ (जैसे योग या गणना)  
5. सबटोटल लागू करने के िलए ठीक İƑक करŐ ।  

 

Advantages (लाभ):  

1. मानदंड के आधार पर डेटा को समूहबȠ और सारांिशत करके आसान डेटा िवʶेषण। 
2. उप-योग गणना को ˢचािलत करके और ũुिटयो ंको कम करके बेहतर सटीकता।  
3. डेटा को ŵेिणयो ंऔर उपŵेिणयो ंमŐ समूिहत करके उɄत संगठन। 

 

Using “What If” Scenarios 

“What if” Scenerio एक ऐसी सुिवधा को संदिभŊत करता है जो आपको िविभɄ पįरणामो ंया संभावनाओ ंका पता लगाने के 

िलए डेटा के िविभɄ सेट बनाने और तुलना करने की अनुमित देता है। Scenerio उपयोगी होते हœ जब आप यह पता लगाना 
चाहते हœ िक डेटा मŐ पįरवतŊन आपकी गणनाओ ंको कैसे Ůभािवत करेगा, जैसे िक िवȅीय मॉडिलंग या पूवाŊनुमान मŐ। 
Scenerio मŐ "What if " िवʶेषण, आप िविभɄ संभावनाओ ंका परीƗण कर सकते हœ और अपने डेटा मŐ पįरवतŊनो ं के 

संभािवत Ůभाव का पता लगा सकते हœ, िजससे आपको अिधक सूिचत िनणŊय लेने मŐ मदद िमलती है। 



Steps:  

1. OpenOffice मŐ एक नई या मौजूदा spreadsheet खोलŐ।  
2. Original data दजŊ करŐ  िजसे आप अपने scenerio के आधार के ŝप मŐ उपयोग करना चाहते हœ। 
3. Menu बार से Tools > scenerio पर İƑक करŐ ।  
4. Scenerio संवाद बॉƛ मŐ, नया scenerio बनाने के िलए sum पर İƑक करŐ।  
5. अपने scenerio को एक नाम दŐ  और उन cells का चयन करŐ  िजɎŐ आप अपने scenerio मŐ बदलना चाहते हœ। 
6. अपने scenerio मŐ Ůȑेक cell के िलए नए values(मान) दजŊ करŐ ।  
7. अपना scenerio सहेजने के िलए ok İƑक करŐ ।  
8. अितįरƅ scenerio बनाने के िलए चरण 4-7 दोहराएं। 
9. Scenerio की तुलना करने के िलए, Tool > scenerio पर İƑक करŐ  और उन scenerio का चयन करŐ  िजनकी आप 

तुलना करना चाहते हœ। 
 

Advantages (लाभ): 

1. अपने डेटा को बेहतर ढंग से समझने और अिधक सूिचत िनणŊय लेने मŐ आपकी सहायता करता है।  
2. िवशेष ŝप से िवȅीय मॉडिलंग, पूवाŊनुमान और अɊ Ɨेũो ंमŐ उपयोगी जहां आपको अपने डेटा पर िविभɄ चरो ंके 

Ůभाव का पता लगाने की आवʴकता होती है। 
3. डेटा के िविभɄ सेटो ंऔर उनके संभािवत Ůभाव की तुलना और तुलना करने का एक तरीका Ůदान करता है। 

 

Using Goal Seek  

Electronic spreadsheet मŐ Goal seek एक ऐसी सुिवधा को संदिभŊत करता है जो आपको िविशʼ output value Ůाɑ करने 

के िलए आवʴक input value खोजने की अनुमित देता है। यह उपयोगी हो सकता है जब आप गणना के वांिछत पįरणाम 

को जानते हœ, लेिकन आप सुिनिʮत नही ंहœ िक उस पįरणाम को Ůाɑ करने के िलए कौन से input की आवʴकता है। 
Steps:  

1. उस formula को दजŊ करŐ  िजसे आप उस cell मŐ उपयोग करना चाहते हœ जहाँ आप चाहते हœ िक output value 

िदखाई दे।  
2. उस input cell के िलए Ůारंिभक value दजŊ करŐ  िजसे आप बदलना चाहते हœ।  
3. Menu बार से Tools > Goal Seek पर İƑक करŐ ।  
4. Goal Seek dialog box मŐ, वह output value दजŊ करŐ  िजसे आप Ůाɑ करना चाहते हœ और उस सेल का चयन करŐ  

िजसमŐ वह input value है िजसे आप बदलना चाहते हœ। 
5. Goal Seek analysis चलाने के िलए ok पर İƑक करŐ ।  
6. Goal Seek सुिवधा वांिछत output Ůाɑ करने के िलए आवʴक value की गणना करेगी और input cell को नए 

value के साथ अपडेट करेगी। 
 

Using the Solver (सॉʢर का उपयोग करना) 
सॉʢर गोल सीक का अिधक उɄत संˋरण है। जबिक लƙ सीक को एकल चर समाधान खोजने के िलए िडज़ाइन िकया 
गया है, सॉʢर कई अǒात चर वाले समीकरणो ंको संभाल सकता है। इसका उपयोग सवŖȅम संभव पįरणाम खोजने के िलए 

िकया जाता है जो पįरभािषत शतŘ के एक सेट को पूरा करता है, जैसे िक आपके Ȫारा पįरभािषत िनयमो ंया बाधाओ ंके 

आधार पर िकसी िवशेष पįरणाम को Ɋूनतम या अिधकतम करना। 
 
 
 
 
 
 
 
 



 

बŠ िवकʙीय Ůʲ। (Multiple Choice Questions) 

Q1. िनɻिलİखत मŐ से कौन सा आपको अपने डेटा को अलग से इकǧा करने की अनुमित देता है वकŊ शीट को माːर 

वकŊ शीट मŐ बदलना।  
1. सॉʢर (Solver) 

2. समेिकत (Consolidate) 

3. ˚ेडशीट (Spreadsheet) 

4. पįर̊ʴ (Scenario) 

 

 Q2. िनɻिलİखत मŐ से कौन सा "Ɛा-अगर" Ůʲो ंका परीƗण करने के िलए एक उपकरण है।  
1. कायŊपũक (Worksheet) 

2. सॉʢर (Solver) 

3. पįर̊ʴ (Scenario) 

4. लƙ की तलाश (Goal Seek) 

 

Q3. टूल मेɊू के अंतगŊत िनɻ मŐ से कौन सा िवकʙ लƙ खोज (Goal Seek) का ŝप अिधक िवˑृत है ।  
1. लƙ की तलाश (Goal Seek) 

2. सॉʢर (Solver) 

3. समेिकत (Consolidate) 

4. उप-योग (Subtotal) 

 

 Q4. उन कƗो ं(cell) की ŵेणी का चयन करŐ  िजनके िलए आप उप-योगो ं (subtotal) की गणना करना चाहते हœ, और िफर 

_________ चुनŐ -> उप-योग (Subtotal)।  
1. Insert 

2. डेटा 
3. फ़ाइल  

4. Tool 

 

 Q5. इलेƃŌ ॉिनक ˚ेडशीट मŐ __________ एक ऐसी सुिवधा को संदिभŊत करता है जो आपको अनुमित देता है िविशʼ 

आउटपुट मान Ůाɑ करने के िलए आवʴक इनपुट मान ǒात करŐ ।  
1. सॉʢर (Solver) 

2. लƙ की तलाश (Goal seek) 

3. औजार (Tool) 

4. उप-योग (Subtotal) 

 

योƶता आधाįरत Ůʲ (Competency based Questions) 

Q1. मान लीिजए िक मनीष के पास 10,000 डॉलर हœ, िजसके िलए आप दो ʄूचुअल फंड मŐ एक वषŊ के िलए िनवेश करना 
चाहते हœ । फंड X 8% ɯाज दर के साथ एक कम जोİखम वाला फंड है और फंड Y 12% ɯाज दर के साथ उǄ जोİखम 

वाला फंड। $1000 का कुल ɯाज अिजŊत करने के िलए Ůȑेक कोष मŐ िकतना पैसा लगाना चािहए? ˚ैडशीट की िकस 

िवशेषता का उपयोग उसकी गणना के िलए िकया जा सकता है?  

1. लƙ की तलाश (Goal Seek) 

2. सॉʢर (Solver) 

3. उप-योग (Subtotal) 

4. पįर̊ʴ (Scenario) 

 



 Q2. सोहा एक छाũा अपने लƙो ंकी योजना बना रही है िक उसे िकस अंक मŐ Ůाɑ करना चािहए आगामी सेमेːर 4 

परीƗाओ ंमŐ एक अंतर (75%) Ůाɑ करने के िलए। इसकी गणना करने के िलए ˚ेडशीट की िकस िवशेषता का उपयोग 

िकया जा सकता है। 
1. सॉʢर (Solver) 

2. लƙ की तलाश (Goal Seek) 

3. उप-योग (Subtotal) 

4. समेिकत (Consolidate) 

 

लघु उȅरीय Ůʲ (Short Answer Questions)  

Q1 सॉʢर और गोल सीक के बीच अंतर।  
Q2 ˚ैडशीट की लƙ तलाश (Goal Seek) सुिवधा के Ɛा लाभ हœ?  

Q3 गोल सीक का उɄत संˋरण कौन सा है और कैसे?  

Q4 डेटा समेकन (Consolidation) से आपका Ɛा मतलब है?  

 

दीघŊ उȅरीय Ůʲ (Long Answer Questions) 

Q1. आप ˚ेडशीट मŐ डेटा को कैसे समेिकत कर सकते हœ? 

 Q2. ŵेणी या समूह Ȫारा डेटा को सारांिशत करने की अनुमित देने के िलए सुिवधा और चरण िलखŐ, जʗी से Ůȑेक समूह के 

िलए कुल देखने के िलए? 

 

SESSION 2: LINK DATA AND SPREADSHEETS 

सũ 2: िलंक डेटा और ˚ेडशीट्स  

आप ˚ैडशीट्स का उपयोग करके कई ŷोतो ंसे डेटा को सारांिशत करने के िलए कई वकŊ शीट्स और ˚ैडशीट्स से सेल 

िलंक भी कर सकते हœ। यह आपको सूũ बनाने की अनुमित देता है जो कई ŷोतो ंसे डेटा को जोड़ता है और िलंक िकए गए 

और ˕ानीय डेटा दोनो ंका उपयोग करके गणना करता है। नई शीट सİʃिलत करना जब आप एक नई ˚ैडशीट खोलते हœ, 
तो इसमŐ आमतौर पर शीट1, शीट2 और शीट3 नाम की तीन शीट होती हœ। यिद आप ˚ैडशीट मŐ एक नई शीट सİʃिलत 

करना चाहते हœ, तो आप िविभɄ िविधयो ंका उपयोग कर सकते हœ।  
नई शीट बनाने के चरण –  

1. Menu बार से Insert > Sheet चुनŐ,  
2. टैब पर राइट-İƑक करके शीट डालŐ, 
3. शीट टैब के अंत मŐ खाली Ɨेũ मŐ İƑक करŐ।  

 

Renaming Sheets 

1. चरण 1: मौजूदा वकŊ शीट के नाम पर डबल-İƑक करŐ । 
2. चरण 2: Context menu का उपयोग करŐ  जो तब Ůकट होता है जब आप नाम बदलŐ का चयन करने के िलए िकसी 

मौजूदा worksheet के नाम पर राइट-İƑक करते हœ।  
3. चरण 3: िजस वकŊ शीट का आप नाम बदलना चाहते हœ उसे चुनने के िलए वकŊ शीट टैब पर İƑक करŐ  और िफर 

फॉमőट मेɊू से शीट िवकʙ चुनŐ। जब आप ऐसा करते हœ तो ŮदिशŊत होने वाले सबमैɊू से नाम बदलŐ िवकʙ चुना 
जाना चािहए।  

 

Cell Reference (सेल संदभŊ) 
˚ेडशीट मŐ सेल रेफरŐ िसंग एक िविशʼ पहचानकताŊ का उपयोग करके वकŊ शीट के भीतर एक िविशʼ सेल या सेल की ŵेणी 
को संदिभŊत करने की ŮिŢया है। इस िविशʼ पहचानकताŊ को cell reference कहा जाता है और यह एक कॉलम अƗर और 

एक पंİƅ संƥा के संयोजन से बना होता है जो िकसी िवशेष सेल के ˕ान की पहचान करता है।  
 

 

 



 

Referencing Other Sheets (अɊ शीट्स को संदिभŊत करना) 
अɊ शीट्स मŐ सेलो ंको संदिभŊत करने के दो तरीके हœ:  

1. सीधे कीबोडŊ  का उपयोग करके या माउस का उपयोग करके सूũ दजŊ करके।  
2. Creating The Reference with The Mouse (माउस के साथ संदभŊ बनाना) 
3. माउस से संदभŊ बनाने के िलए दोनो ं˚ैडशीट खुली होनी चािहए। वह सेल चुनŐ जहां सूũ दजŊ िकया जाएगा। 

 

Creating The Reference with The Keyboard (कीबोडŊ  के साथ संदभŊ बनाना) 
संदभŊ सूũ मŐ कीबोडŊ  का उपयोग करके सेल संदभŊ दजŊ करना आसान है। संदभŊ मŐ तीन भाग होते हœ: 

1. Path and file name (पथ और फ़ाइल का नाम) 

2. sheet name (पũक का नाम) 

3. Cell (कƗ) 

 

Working with Hyperlinks (हाइपरिलंƛ के साथ काम करना) 
Calc मŐ, आप ˚ैडशीट सेल के बीच और समान या िभɄ फ़ाइलो,ं वेबसाइटो,ं या यहां तक िक अɊ ˚ैडशीट के अɊ Ɨेũो ंमŐ 
नेिवगेट करने के िलए हाइपरिलंक का उपयोग कर सकते हœ।  
हाइपरिलंƛ को आपकी फ़ाइल मŐ या तो relative or absolute के ŝप मŐ संŤहीत िकया जा सकता है। 
 

Relative and Absolute हाइपरिलंƛ 

 Relative and Absolute हाइपरिलंƛ का उपयोग ˚ेडशीट अनुŮयोगो ंमŐ िकया जाता है, जैसे ओपनऑिफस Calc, उसी 
˚ेडशीट के भीतर या बाहरी फाइलो ंऔर वेब पेजो ंके भीतर cell या अɊ संसाधनो ंके बीच िलंक बनाने के िलए।  
Relative हाइपरिलंƛ - įरलेिटव हाइपरिलंƛ वे िलंक होते हœ जो वतŊमान सेल के ˕ान के संबंध मŐ िनिदŊʼ होते हœ। वे आम 

तौर पर उस पथ का उपयोग करते हœ जो वतŊमान फ़ाइल के ˕ान से संबंिधत है। उदाहरण के िलए, यिद आप वतŊमान मŐ सेल 

A1 पर हœ और उसी शीट मŐ सेल B1 से िलंक करना चाहते हœ, तो आप संबंिधत हाइपरिलंक "B1" का उपयोग कर सकते हœ।  
Absolute हाइपरिलंƛ - Absolute हाइपरिलंƛ, दूसरी ओर, िलंक िकए जा रहे संसाधन का पूरा पथ या URL िनिदŊʼ करते 

हœ। उदाहरण के िलए,  

“https://cbseskilleducation.com/information-technology-class-10-notes/”, you can use the absolute hyperlink 

“https://cbseskilleducation.com/information-technology-class-10-notes/”. 

 

Linking to External Data (बाहरी डेटा से िलंक करना) 
बाहरी डेटा डालने के िलए, जैसे िक HTML दˑावेज़ो ंसे तािलकाएँ या अɊ ˚ैडशीट्स से नािमत ŵेिणयाँ, OpenOffice Calc 

मŐ, आप बाहरी डेटा संवाद या नेिवगेटर का उपयोग कर सकते हœ। 
 

 1. External Data dialog का उपयोग करना: Data > “External Data” पर जाएं, डेटा के ŷोत का चयन करŐ  और सİʃिलत 

करने के िलए िविशʼ डेटा चुनŐ। आप बाहरी डेटा से िलंक कर सकते हœ या इसे अपनी ˚ैडशीट मŐ कॉपी कर सकते हœ।  
 

2. नेिवगेटर का उपयोग करना: "नेिवगेटर" आइकन पर İƑक करŐ  या F5 दबाएं, “Data Sources” अनुभाग (section)  का 
िवˑार करŐ , डेटा के ŷोत का चयन करŐ , और तािलका या नामांिकत ŵेणी को अपने Ɨेũ मŐ खीचंŐ और छोड़Ő  
 

बŠ िवकʙीय Ůʲ। (Multiple Choice Questions) 

Q1. वकŊ शीट पर एक सेल या सेल की एक ŵेणी को Ɛा संदिभŊत करता है और इसका उपयोग उन मानो ंया डेटा को खोजने 

के िलए िकया जा सकता है िजनकी गणना करने के िलए आप सूũ चाहते हœ। 
1. सेल (cell) 

2. उप-योग (Subtotal) 

3. सेल संदभŊ (Cell reference) 

4. डेटा िलंक (Data Link) 



 

Q2. ______ का उपयोग Calc मŐ एक ˚ेडशीट के भीतर से एक अलग ˕ान पर जाने के िलए िकया जा सकता है और 

वतŊमान फ़ाइल के अɊ भागो ंमŐ, िविभɄ फ़ाइलो ंया यहां तक िक वेब साइटो ंके िलए भी।  
1. सेल संदभŊ (Cell Reference) 

2. हाइपरिलंक (Hyperlink) 

3. इंटरनेट (Internet) 

4. ˚ेडशीट (Spreadsheet) 

 

Q3.  ______ चुनŐ -> बाहरी डेटा (External Data) से िलंक करŐ। 
1. डालना (Insert) 

2. डेटा (Data) 

3. फ़ाइल (File) 

4. औजार (Tool) 

 

Q4. एक _________ िलंक तभी काम करना बंद करेगा जब Ůारंभ और लƙ ˕ान एक दूसरे के सापेƗ (relative) बदलते 

हœ। 
1. Absolute 2. Mixed 3. Relative 

 

 Q5. $A$1 संदभŊ का एक उदाहरण है।  
2. Absolute 2. Mixed 3. Relative 

 
लघु उȅरीय Ůʲ (Short Answer Questions) 

Q1. ˚ैडशीट मŐ नई शीट डालने के चरण िलखŐ? 

Q2. ˚ेडशीट मŐ शीट का िडफ़ॉʐ नाम Ɛा है और आप कैसे नाम बदल सकते हœ?  

Q3. बाहरी डेटा से िलंक करने के दो तरीके कौन से हœ? 

 

 दीघŊ उȅरीय Ůʲ (Long Answer Questions) 

Q1. अɊ शीट मŐ सेल रेफरŐस बनाने के दो तरीको ंको समझाइए।  
Q2. िनरपेƗ (Absolute)और सापेƗ (Relative) संदभŊ के बीच अंतर िलखŐ? 

 

SESSION 3: SHARING WORKSHEET DATA 

सũ 3 : वकŊ शीट डेटा शेयर करना 
 

डेटा sharing करने के िलए Spreadsheet को कैसे set करŐ  : 
िकसी भी समय, Spreadsheet शेयर करने के िलए Spreadsheet सेट करते हœ, िजसके िलए िनɻ Steps है | 

1. Spreadsheet Document को खोलŐगे ।  
2. Tools मैɊू मŐ जायŐगे।  
3. िफर शेयर documents को सेलेƃ करŐ गे। शेयर Documents पर İƑक करते ही ंDialog Box open होगा ।  
4. शेयर with other users पर İƑक करŐ गे ।  
5. और अंत मŐ OK पर İƑक करŐ गे ।  

 

Opening A Shared spreadsheet (एक शेयडŊ  ˚ेडशीट खोलना) 
जैसे ही ंआप spreadsheet document को शेयर मोड मŐ open करते हœ, तो एक message display होगा, जहाँ आपको पता 
चलता है िक document शेयर मोड मŐ है ।  
OK पर İƑक करके आप Document को शेयर मोड मŐ खोल सकते हœ ।  
 



Saving A Shared Spreadsheets (शेयडŊ Spreadsheet को Save करना): 
जब आप शेयर spreadsheet को save करते हœ, तो कुछ Situations हो सकती है ।  

1. यिद वकŊ शीट मŐ modify नही ंŠआ और दूसरे उपयोगकताŊ Ȫारा save िकया गया हो तो वह Save होगा ।  
2. यिद वकŊ शीट मŐ modification Šआ हो तो दूसरे उपयोगकताŊ को एक लाल बॉडŊर िदखेगा ।  

 

Record Changes (įरकॉडŊ  पįरवतŊन): 

Calc के पास ˙ेशल feature है, िजससे वह िकसी spreadsheet के अंदर डेटा पįरवतŊन को track कर सकता है । जैसे िक 

"Who made the change" और "when the change made" तथा " Ɛा पįरवतŊन िकया गया " ।  
 

Start recording changes in Spreadsheet 

1. Spreadsheet को खोलŐ ।  
2. सेलेƃ Edit > Changes > įरकॉड्Ŋस from मेɊू बार ।  
3. Worksheet मŐ Editing शुŜ करŐ  ।  
 

Viewing Changes (पįरवतŊन को देखना): 
Calc मŐ हम įरकॉडŊ  पįरवतŊन को देखने के िलए िनɻ ːेप अपनाएंगे ।  
सेलेƃ Edit > पįरवतŊन > Show.  

यहाँ एक dialog box खुलेगा ।  
जहाँ आप अलग- अलग Setting का Ůयोग कर सकते हœ ।  

 Date  

 Range 

 Comment 

 Show Accepted Changes 

 Show Rejected Changes 

 

Adding Comments to Changes (पįरवतŊन मŐ Comment को जोड़ना) 
Calc अपने आप िकसी भी įरकॉडŊ के िलए पįरवतŊन को एक Comment मŐ जोड़ता है, जो describe करता है िक Ɛा पįरवतŊन 

Šआ।  
1. Spreadsheet मŐ बदलाव करŐ  ।  
2. पįरवतŊन के साथ सेल को सेलेƃ करना ।  
3. िफर Edit > पįरवतŊन > comments सेलेƃ करŐ  ।  
4. Comment टाईप करŐ  ।  
5. OK पर İƑक करŐ  ।  

Edit Changes Comments (पįरवितŊत Comment को Edit करना) 
1. Worksheet को खोलŐ ।  
2. सेलेƃ सेल, िजसका Comment बदलना चाहते हœ ।  
3. उसके बाद Edit > Changes > Comments पर जाएं ।  
4. Comment को Edit करŐ  ।  
5. OK पर İƑक करŐ  ।  

 

Accept or Reject Changes (पįरवतŊनो ंको Accept और Reject करना) 
Accept और Reject Changes के िलए िनɻ कदम है ।  

1. Edit िकए गए Document को खोलŐ ।  
2. सेलेƃ Edit > Changes > Accept और Reject पर İƑक करŐ , Dialog Box खुलेगा ।  
3. Dialog Box मŐ आप Accept, Accept All, Reject, Reject All मŐ से िकसी भी option पर İƑक कर सकते हœ, जो 

आप चाहते हœ ।  



Merging worksheets (Worksheet को मजŊ करना) 
िकसी Document को merge करने के िनɻ Steps(कदम) है ।  

1. Original Document को खोलŐ ।  
2. िफर Edit > Changes > Merge Document पर जाएँ ।  
3. File Selection डायलॉग बॉƛ खुल जायेगा ।  
4. उस फाईल को सेलेƃ करŐ  िजसे मजŊ करना चाहते हœ ।  
5. OK पर İƑक करŐ  ।  
6. Document merge होने के बाद Accept और Reject का डायलॉग बॉƛ खुलेगा ।  
7. आप Accept या Reject जो करना चाहŐ कर सकते हœ ।  
8. एक से अिधक Document को merge करने के िलए 2 या 3 (Step) कदम आप Repeat कर सकते हœ ।  

 

Comparing Document (Document को तुलना करना) 
Libre Office Calc मŐ Documents को तुलना करने के िनɻ चरण है: 

1. Edit Document को open करŐ , िजसे original Document के साथ तुलना करना चाहते हœ ।  
2. उसके बाद Edit > Changes > Compare Document पर जाएँ ।  
3. डायलॉग बॉƛ open होने के बाद original Document Select कर के Insert करŐ  ।  

   

  बŠ िवकʙीय Ůʲ। (Multiple Choice Questions) 

Q1. वकŊ शीट को मजŊ िकया जा सकता है, ______________ मेɊू से । 
1. उपकरण 
2. देखŐ 
3. फ़ाइल 
4. संपािदत करŐ 

 

Q2. दˑावेज़ साझा करने का िवकʙ िकस मेɊू मŐ उपलɩ है? 
1. फ़ाइल 
2. उपकरण 
3. संपािदत करŐ 
4. इनमŐ से कोई नही ं

 

Q3. ________________खुलता है जहां आप साझा करण को सƗम या अƗम करना चुन सकते हœ। 
1. पॉपअप 
2. संवाद 
3. फ़ाइल 
4. ये सभी 

 

Q4. जब कोई दˑावेज़ बनाया और सहेजा जाता है, तो उसमŐ ˢचािलत ŝप से ........... नाम का एक पुˑकालय होता है। 
1. ːैȵडŊ 
2. मॉǰूल 
3. मैŢो 
4. इनमŐ से कोई नही ं

 

Q5. उपयोगकताŊ िविशʼ उपयोगकताŊ के साथ-साथ सभी उपयोगकताŊओ ंȪारा िकए गए पįरवतŊनो ंको ˢीकार या अˢीकार 

कर सकता है। 
1. असȑ  2. सȑ 



Q6. ˚ेडशीट मŐ िकए गए पįरवतŊनो ंको ˢीकार करने के िलए, पįरवतŊन समूह से _______ > _________ > ________ 

िवकʙ पर İƑक करŐ । 
 

Q7. िनɻिलİखत मŐ से कौन सा शॉटŊ  कट की Ɋू इɌटŊ Ɋू कमŐट है? 
1. िशɝ + F1 

2. िशɝ + F2 

3. िशɝ + F3 

4. िशɝ + F4 

 

 लघु उȅरीय Ůʲ (Short Answer Questions) 

Q1. वकŊ शीट डेटा शेयर करने के Ɛा फायदे हœ? 

Q2. ˚ैडशीट साझा करने के चरण िलखŐ। 

Q3. ˚ेडशीट की तुलना और मजŊ करने के चरण िलखŐ। 

Q4. शेयर वकŊ बुक डायलॉग बॉƛ मŐ उपलɩ िविभɄ िवकʙो ंकी ʩाƥा करŐ। 

Q5. साझा कायŊपुİˑका मŐ अɊ उपयोगकताŊओ ंȪारा पįरवतŊनो ंको हाइलाइट कैसे करŐ? 

Q6. ˚ेडशीट मŐ िटɔिणयो ंकी Ɛा भूिमका है? 

Q7. ˚ेडशीट मŐ िटɔणी संपािदत करने के चरण िलखŐ। 

 

 दीघŊ उȅरीय Ůʲ (Long Answer Questions) 

Q1. िटɔणी को Ůाŝिपत करने के िलए उपलɩ िवकʙो ंकी ʩाƥा करŐ  और िटɔणी को हटाने के िलए कदम िलखŐ। 

Q2. Ůदान िकए गए िवकʙो ंकी सूची बनाएं और समझाएं पįरवतŊनो ंको हाइलाइट करŐ  संवाद बॉƛ। 

Q3. ˚ेडशीट मŐ उपयोगकताŊ Ȫारा िकए गए सभी पįरवतŊनो ंको ˢीकार करने के चरणो ंको िवˑृत करŐ । 

Q4. पįरवतŊनो ंको एक-एक करके अˢीकार करने के चरणो ंको सूचीबȠ करŐ । 

Q5. समीƗा टैब मŐ मजŊ और तुलना िवकʙ कैसे जोड़Ő  ȕįरत एƛेस टूलबार मŐ तुलना िवकʙ की भी ʩाƥा करŐ? 

 

योƶता आधाįरत Ůʲ:(Competency Based Question)  

नमन और नयन "माई Ůोजेƃ" नाम के ओपन ऑिफस Calc की एक फाइल मŐ काम कर रहे हœ। वे "माई Ůोजेƃ" फ़ाइल मŐ 
एक नई शीट डालना चाहते हœ। साथ ही वे Ůोजेƃ लीडर नंदन के साथ अपनी फाइल साझा करना चाहते हœ। 
इस शतŊ के आधार पर िनɻिलİखत के उȅर दीिजए। 
Q1. "माई Ůोजेƃ" फाइल का एƛटŐशन Ɛा है? 

Q2. नई शीट डालने के कोई दो तरीके िलİखए। 

Q3. "माई Ůोजेƃ" फ़ाइल मŐ उपलɩ शीट की िडफ़ॉʐ संƥा Ɛा है? 

Q4. नंदन के साथ फाइल शेयर करने के िलए नमन और नयन को ................... मेɊू पर İƑक करना होगा। 

 

 

 

 

 

 

 



SESSION 4: CREATE AND USE MACROS IN SPREADSHEET 

सũ 4 :  ˚ैडशीट मŐ मैŢोज़ बनाना और Ůयोग करना 
 

Macro (मैŢो)   
Macros Spreadsheet का एक महȕपूणŊ feature है, एक ही ंकायŊ (work) को बार- बार Ůयोग करने के िलए Macros 

Record कर लेता है, और जब पुनः  उसकी जŝरत पड़े तो उसे दुबारा करने की बजाय Macro से कर लेते हœ । ऐसा करने से 

समय की बचत होती है ।  
नोट: 

Macros Command के Steps को Save करके रख लेता है, तािक पुनः  उपयोग कर सके ।  
Using the Macro Recorder (मैŢो Recorder का Ůयोग): 

मैŢो Recorder Ůयोग करने के िनɻ चरण है: 

1. एक नई Spreadsheet खोलŐगे ।  
2. Sheet मŐ value Enter करŐ गे ।  
3. उस सेल को सेलेƃ करŐ गे िजसकी value लेनी है ।  
4. Tools > Macros > Record Macros पर İƑक करŐ गे ।  
5. Record Macros नाम की एक window खुलेगी ।  
6. Work पूरा हो जाने पर Window मŐ "Stop Recording " पर İƑक करŐ गे ।  
7. Basic Macro Window मŐ Macro को save करŐ  ।  
8. मैŢो Record होकर Save हो जायेगा ।  

 

Recorded Macros को Run कैसे करŐ :  
Macros Run करने के िनɻ चरण है: 

1. िजस सेल मŐ Macros Run करना है वहाँ cursor रखŐ ।  
2. Tools > Macros > Run Macros पर İƑक करŐ  ।  
3. Macros Selector नाम की  एक िवंडो खुलेगी ।  
4. उस िवंडो मŐ Macros को सेलेƃ करŐ  ।  
5. Run Macros बटन पर İƑक करŐ  ।  
6. Selected सेल मŐ Macros run होगा ।  

 

Using A Macro as a Function (मैŢो का Ůयोग फंƕन के ŝप मŐ करना) 
इसके अंतगŊत हम मैŢो मŐ Function को जोड़ सकते हœ, इसके िलए िनɻ चरण(Steps) हœ: 

1. Libre Office Calc मŐ Tools > Macro option पर जाते हœ ।  
2. Organize Macros > Basic option पर İƑक करŐ  ।  
3. Macro को सेलेƃ करŐ  और Edit बटन पर İƑक करŐ  ।  
4. िवंडो open होगी, िजसमŐ Function को जोड़Ő  ।  

नोट:  Function Name कभी भी Case-Sensitive नही ंहोगा । जैसे: =NUMBERFIVE() 

  

Passing Arguments to macros (Macros मŐ Arguments को pass करना) 
Function के अंदर िकसी value को pass करना ही ंPass Arguments कहलाता है ।  
जैसे: Test Max (x, y); 

इस function मŐ 'x' और 'y' Arguments है।  
उदाहरण: Spreadsheet मŐ A1 और B1 सेल मŐ जो Value है, उसे compare करना है िक कौन बड़ी है, इसके िलए Test 

Max(x, y) function का Ůयोग िकए। हम Arguments मŐ function को िनɻ तरीके से Pass करते हœ: 
 

 

 



Text Max (A1:B1)  

Function Test Max(x, y)  

          if x > = y Then 

           Test Max = x 

       Else  

           Test Max = y 

       End if 

      End function 

 

Passing Arguments as Values (Arguments को Value के ŝप मŐ Pass करना) 
यिद िकसी Function मŐ Address की जगह Direct Value Enter करते हœ तो उसे "Passing Arguments as Values" कहते 

हœ।  
जैसे: Test Max (4, 5). 

इस function मŐ हम Direct Value 4 और 5 पास करते हœ ।  
 

Writing Macros like built-in-functions (Macros function को built-in-function के ŝप मŐ िलखना) 
Built-in-functions पहले से बने function होते हœ, जो Standard Library मŐ होते हœ ।  
Macros को Built-in-functions बनाने के िलए उɎŐ Standard Library मŐ जोड़ना पड़ता है।  
 

Accessing Cells Directly (सीधे Cells तक पŠँचना) 
िकसी सेल की Value को direct उपयोग करना ही ं"Accessing Cell directly" कहलाता है ।  
हम Macros function मŐ शीट और सेल के Address के Ȫारा Cells को directly access कर सकते हœ ।  
Ex: Ůȑेक शीट मŐ सेल को जोड़ना 
Function SumCells All Sheets ()  

Dim The Sum As Double 

Dim I As Integer 

Dim o Sheets 

Dim o sheet 

Dim o cell 

O sheets = This component. getSheets()  

For I = O to O sheets.getcount() -1 

Osheet = O sheet = o sheet.getBy Indec (i)  

OCell = Osheet.getCell By position (0, 1)  

The Sum = The Sum + OCell.get value()  

Next 

Sum CellsAll Sheets = The Sum 

End function 

 

Sorting (छँटाई करना) 
Open Office Calc मŐ Macro create करके डाटा को Direct/Automatic (ˢतः ) Sort कर सकते हœ।  
Libre Office Calc मŐ Columns की value को Sort करने के िनɻ चरण है: 

1. Libre Office Calc मŐ Values को Enter करŐ  ।  
2. Tools > Macros > Record Macros पर İƑक करŐ  ।  
3. Macro Recirding शुŝ हो जायेगी ।  
4. Accending /Descending option से value को sort करŐ  ।  
5. Stop Recording पर İƑक करŐ  ।  
6. Basic Macro िवंडो मŐ macro को save करŐ  ।  
7. Column के मान(value) को sort करने के िलए Micros function बन जायेगा ।  



  बŠ िवकʙीय Ůʲ। (Multiple Choice Questions) 

Q1. डेटा को केवल दो शीट से समेिकत िकया जा सकता है। 
1. सȑ  2. असȑ 

 

Q2. Calc की कौन सी िवशेषता साझा वकŊ शीट मŐ िकए गए पįरवतŊनो ंको देखने मŐ मदद करती है। 
1. सॉʢर 

2. सबटोटल 

3. įरकॉडŊ  पįरवतŊन 

4. इनमŐ से कोई नही ं
 

Q3. ___________ कमांड्स और की Ōː ोƛ का से̺ड सीकवुआनस है जो बाद मŐ उपयोग के िलए ːोर िकया जाता है। 
1. सॉʢर 

2. साझा करना 
3. मैŢो 
4. ऑटोसम 

 

Q4. मैŢो को संपािदत करने के िलए, हम __________का उपयोग करते हœ। 
1. ʩू > मैŢोज़ > एिडट मैŢोज़ 

2. टूʤ > मैŢोज़ > एिडट मैŢोज़ 

3. एिडट > मैŢोज़ > एिडट मैŢोज़ 

4. सेलेƃ > मैŢोज़ > एिडट मैŢोज़ 
 

Q5. मैŢो įरकॉडŊर शुŝ करने के िलए िनɻिलİखत मŐ से िकसका उपयोग िकया जाता है? 

1. टूʤ > įरकॉडŊ  > įरकॉडŊ  मैŢो 
2. डेटा > įरकॉडŊ  > įरकॉडŊ मैŢो 
3. टूʤ > मैŢोज़ > įरकॉडŊ  
4. इनमŐ से कोई नही ं

 

Q6. Calc मŐ फ़ंƕन का नाम केस सŐिसिटव नही ंहोता है। 
1. सȑ  2.  असȑ 

 

Q7. मैŢोज़ िवशेष ŝप से उपयोग िकए जाते हœ। ____________ एक कायŊ। 
1. तुलना करŐ  
2. पूणŊ 
3. दोहराएँ 

4. सरल करŐ 
 

Q8. ____________ Calc मŐ मैŢो बनाकर ओपन ऑिफस मŐ डेटा को ऑटोमेटेड िकया जा सकता है। 
1. संपादन 

2. छँटाई 

3. कायाŊɋयन 

4. इनमŐ से कोई नही ं
 

 

 
 



लघु उȅरीय Ůʲ (Short Answer Questions) 

Q1. मैŢोज़ Ɛा हœ? 

Q2. छँटाई से आप Ɛा समझते हœ? 

Q3. Libre office calc मŐ मैŢो įरकॉडŊ  करने के ːेɛ िलखŐ। 
Q4. मैŢोज़ के लाभ िलİखए। 
Q5. ओपन ऑिफस calc मŐ मैŢो कैसे चलाएं? 

Q6. ओपन ऑिफ़स calc मŐ एक फ़ंƕन के ŝप मŐ मैŢो का उपयोग कैसे करŐ? 

 

दीघŊ उȅरीय Ůʲ (Long Answer Questions) 

Q1. मैŢो को पįरभािषत करŐ । मैŢो įरकॉडŊ करने के ːेɛ िलखŐ? 

Q2. मैŢो का उपयोग करके ओपनऑिफस calc मŐ डेटा को सॉटŊ  करने के िलए चरणो ंको िलखŐ? 

Q3. "छँटाई" से आप Ɛा समझते हœ? िलबर ऑिफस calc मŐ सॉिटōग के लाभ समझाइए। 
 

योƶता आधाįरत Ůʲ:(Competency Based Question)  

सुŵी कंचन कƗा 10 की कƗा िशिƗका है। वह calc मŐ काम कर रही है और पाँच िवषयो ंके अंक डालने के िलए वकŊ शीट 

तैयार कर रही है। वह इस बात को लेकर असमंजस मŐ है िक एक İƑक मŐ वकŊ शीट की सœपल कॉपी कैसे तैयार की जाए। 
बताएं िक वह अपनी जŝरतो ंको पूरा करने के िलए मैŢो का उपयोग कैसे कर सकती है? 

Q1. िनɻ मŐ से कौन सा कमांड या टैब को įरबन मŐ जोड़ने मŐ मदद करता है? 

1. होम           2. इɌटŊ             3. फाइल                        4. įरʩू 

 

Q2. मैŢो įरकॉिडōग शुŝ करने के िलए िनɻ मŐ से िकस बटन को İƑक करने की आवʴकता है? 

1. िवज़ुअल बेिसक       2. मैŢोज़          3. įरकॉडŊ मैŢो       4. सापेƗ संदभŘ का उपयोग करŐ 
 

Q3. सूची मŐ ːोर मैŢो मŐ िनɻ मŐ से कौन सा िवकʙ उपलɩ नही ंहै? 

1. यह वकŊ बुक             2. Ɋू वकŊ बुक            3.पसŊनल मैŢो वकŊ बुक             4. शीट1 
 

Q4. िनɻ मŐ से कौन सा िवकʙ मैŢो डायलॉग बॉƛ मŐ मैŢो का सारांश बताता है? 

1. मैŢो नाम               2. िववरण                3. बटन                       4. मैŢोज़ की सूची 
 

 



                         

UNIT-3 RELATIONAL DATABASE MANAGEMENT SYSTEMS (BASIC) 

  

 

SESSION 1: APPRECIATE THE CONCEPT OF DATABASE MANAGEMENT SYSTEM  

 

SESSION 2: CREATE AND EDIT TABLES USING WIZARD AND SQL COMMANDS  

 

SESSION 3: PERFORM OPERATIONS ON TABLE  

 

SESSION 4: RETRIEVE DATA USING QUERY  

 

SESSION 5: CREATE FORMS AND REPORTS USING WIZARD  

  



DATABASE MANAGEMENT SYSTEM 

SESSION 1: APPRECIATE THE CONCEPT OF DATABASE MANAGEMENT SYSTEM  

 

DATA : डेटा कच्चे तथ्य और आंकडे हैं। यह ऊंचाई, वजन, नाम, संख्या जैसा कुछ भी हो सकता है। 

 

 

 

DATA PROCESSING: डेटा को छांटने या गणना करने की प्रक्रिया को डेटा प्रोसेससगं कहा जाता है 

INFORMATION: डाटा प्रोसेससगं के पररणाम को सूचना कहा जाता है। 

 

 

DATABASE: एक डेटाबेस इलेक्ट्रॉननक रूप से सॉटट और एक्ट्सेस क्रकए गए डेटा का एक संगठित 

संग्रह है। डेटाबेस डेटा प्रबंधन को आसान बनाता है। 

उदाहरण के सलए एक ऑनलाइन टेलीफोन ननदेसिका डेटाबेस का उपयोग लोगों के फोन नंबर और 

अन्य संपकट  वववरणों के डेटा को संग्रहीत करने के सलए करती है। 

उदाहरण के सलए-फेसबुक सदस्यों, उनके दोस्तों , संदेि ,ववज्ञापन आठद से संबंधधत डेटा को स्टोर, हेरफेर 

करके प्रस्तुत करता है। 

 

 

DATA

WORDS

IMAGES

NUMBERS

SEGMENTS

SOUND

VIDEO

DATA DATA PROCESSING INFORMATION



                                                               MTNL TELEPHONE DIRECTORY 

Serial no Name Address Contact number 

1 ANANYA H.no 324,chattarpur  7899003423 

2 AVYUKT Flat no 456, vasant vihar 9874532223 

3 PARIDHI Flat no 403, vasant kunj 9897776342 

4 VRITI H.no 678, karol bagh 7843111113 

 

 

 

ADVANTAGES OF DATABASE 

1. डेटा अनतरेक को कम करता है: अनतरेक को दोहराव की आवश्यकता होती है। दोहराव को 

रोकने के सलए डेटा को एक फाइल में संग्रहीत क्रकया जाता है। 

2. डेटा साझा करना: डेटा को अधधकृत उपयोगकताटओं के साथ साझा क्रकया जा सकता है। 

3. डेटा अखंडता: डेटाबेस में डेटा सटीक और सुसंगत है। 

4. डेटा सुरक्षा: केवल अधधकृत उपयोगकताट को ही डेटाबेस तक पहुुँचने की अनुमनत दी जानी 

चाठहए। 

5. गोपनीयता: केवल अधधकृत उपयोगकताट ही अपनी गोपनीयता की कमी के अनुसार क्रकसी 

डेटाबेस तक पहुुँच सकता है। 

6. बैक अप और ररकवरी: उपयोगकताट को समय-समय पर डेटा बैकअप करने की आवश्यकता 

नहीं होती है। यह ससस्टम के िैि या फेल होने के बाद भी डेटा को ररस्टोर करता है। 

7. डेटा संगतता: पुराना डेटा डेटाबेस में लगातार ठदखाई देता है और जो सभी उपयोगकताटओं के 

सलए समान होना चाठहए। 

 

FEATURES OF DATABASE     

1. एक डेटाबेस में एक या कई टेबल हो सकते हैं। 

2. डेटाबेस में प्रत्येक तासलका में एक प्रकार की वस्तुओं के बारे में जानकारी होती है। 

3. एक डेटाबेस हर तासलका में ववसिष्टता बनाए रखता है। 

4. प्रत्येक डेटाबेस में कंुजी के रूप में ननठदटष्ट एक या अधधक फील्ड होनी चाठहए। 

5. डेटा का संगिन 

6. एकाधधक उपयोगकताट पहंुच होनी चाहिए। 

7. भंडारण स्थान और लागत बचाएं। 



 DATABASE COMPONENTS 

 

 

 

 

Database programs are:  Microsoft access ,open office.ORG Base, MySQL. 

 

TYPES OF DATABASE 

Flat file: डेटा की कम मात्रा के सलए उपयुक्ट्त एकल तासलका में संग्रहीत डेटा। 
Relational: कई तासलकाओं में संग्रहीत डेटा और तासलकाओं को एक सामान्य क्षेत्र का उपयोग 

करके जोडा जाता है। संबंधपरक डेटाबेस मध्यम से बडी मात्रा में डेटा के सलए उपयुक्ट्त है। 
 

DBMS software are: 

Oracle, IBM DB2, Microsoft SQL Server, Microsoft access, Postgre SQL, Mysql, 

FoxPro, SQLite. 

DATABASE SERVER: ये वो समवपटत कंप्यूटर हैं जो वास्तववक डेटाबेस रखते हैं और केवल 

DBMS और संबंधधत सॉफ़्टवेयर चलाते हैं। डेटाबेस सवटर को बैक एंड कहा जाता है, इस प्रकार के डेटा 

एक्ट्सेस को क्ट्लाइंट सवटर मॉडल कहा जाता है। 
 

 

 

HARDWARE

SOFTWARE

DATAPROCEDURE

DATA 

ACCESS 

LANGUAGE



TYPES OF KEYS IN DATABASE 

Primary key: एक प्राथसमक कंुजी आमतौर पर तासलका की ववसिष्टता पर कें ठित होती है। यह 

सुननश्श्चत करता है क्रक ववसिष्ट कॉलम में मान अद्ववतीय है और िून्य नहीं है। 

 

Foreign key: एक ववदेिी कंुजी का उपयोग आम तौर पर दो तासलकाओं के बीच संबंध बनाने के 

सलए क्रकया जाता है। यह एक से अधधक ववदेिी कंुजी की अनुमनत दे सकता है। 

 

Composite key: एक समग्र कंुजी एक उम्मीदवार कंुजी है श्जसमें दो या दो से अधधक वविेषताएुँ 

/ स्तंभ होते हैं जो एक साथ तासलका पंश्क्ट्त की ववसिष्ट पहचान करते हैं। 

 

Unique key: एक अनूिी कंुजी तासलका के एक या एक से अधधक स्तंभों का समूह है जो ववसिष्ट 

रूप से डेटाबेस ररकॉडट की पहचान करती है। अद्ववतीय कंुजी तासलका स्तंभ के सलए िून्य मानों को 

छोड सकती है। 

 

S.NO PRIMARY KEY FOREIGN KEY 
1 तासलका में एक प्राथसमक कंुजी हो 

सकती है। 

 

तासलका में कई अद्ववतीय कंुश्जयाुँ हो सकती 

हैं। 

 

2 यह अिक्ट्त स्तंभों की अनु प्राथसमक 

कंुजी इकाई अखंडता को लागू करने की 

अनुमति नहीं देता है। 

 

यह अिक्ट्त स्तंभों की अनुमनत देता है। 

 

3 डडफॉल्ट इंडेक्ट्स क्ट्लस्टर क्रकया गया है 

 

डडफॉल्ट अनुिमणणका क्ट्लस्टर नहीं है। 

 

4 प्राथसमक कंुजी इकाई अखंडता को लागू 

करना है। 

 

अद्ववतीय डेटा को लागू करने के सलए 

अद्ववतीय कंुजी है। 

 

 

  



SESSION 2: CREATE AND EDIT TABLES USING WIZARD AND SQL COMMANDS  

एक नया डेटाबेस बनाना 

Base openoffice.org का डेटाबेस अनपु्रयोग है 

यह आसानी से डेटाबेस के ननमाटण और हेरफेर की अनुमनत देता है। 

 हम ननम्न चरणों का पालन करके डेटाबेस बना सकते हैं। 

 

 

 

 

 

 

 

 

 

 

  

 

Steps to create table 

डेटाबेस बनाने के बाद हमें संबंधधत जानकारी को स्टोर करने के सलए टेबल बनाना होता 
है। हम तीन तरीकों से टेबल बना सकते हैं। 

ववजाडट का उपयोग करके 

डडजाइन व्यू का उपयोग करके 

SQL कमांड का उपयोग करके 

आपके द्वारा तासलका बनाना 

हम वहाुँ फील्ड सेट करने के सलए कुछ नेववगेिन बटन भी देख सकते हैं। 

अगले बटन पर श्क्ट्लक करें। 

फील्ड का प्रकार और स्वरूप सटे करें। 

नए आइकन पर श्क्ट्लक करें। 

 

ड्रॉप डाउन से डेटाबेस ववकल्प का चयन करें 
menu 

अब हमें दो ववकल्प समलते हैं 

1 एक नया डेटाबेस बनाएुँ। 2 मौजूदा एक का उपयोग कर 

अब नेक्ट्स्ट बटन पर श्क्ट्लक करें 

अब डेटाबेस को नए नाम से सेव करें और क्रफननि बटन पर 
श्क्ट्लक करें 



प्राथसमक कंुजी सेट करें और अगला श्क्ट्लक करें। 

अब टेबल का नाम टाइप करें और क्रफननि बटन पर श्क्ट्लक करें। 

डडजाइन दृश्य में तालिका बनाना 

टेबल आइकन पर श्क्ट्लक करें-> डडजाइन व्यू में टेबल बनाएं। 

यह सारणीबद्ध प्रारूप में तासलका प्रदान करता है जहां हम प्रत्येक क्षेत्र में सीधे जानकारी 
दजट कर सकते हैं। 

अब हम फील्ड प्रो बदल सकते हैं 

Data types used in DBMS 

क्रकसी कॉलम में श्जस प्रकार का डेटा हो सकता है या होल्ड हो सकता है, उसे उसका डेटा 
प्रकार कहा जाता है। 

पांच बुननयादी डेटा प्रकार के डेटा हैं श्जन्हें हम तासलका में सश्म्मसलत कर सकते हैं 

 

 

 

 

 

 

 

 

 

 

 

TEXT 

 

 

 

 

Char,Varchar,Binary, 

Varchar_ignorecase 

Numbers 

Integer  

Bigint/smallint 
Real/float

/double 

Decimal  

Boolean 



 

Date/time 

 

 

SQL कमाांड का उपयोग करके तालिका बनाए ँ

 हम टेबल बनाने के सलए क्रिएट टेबल स्टेटमेंट का उपयोग करते हैं। 

ससटेंक्ट्स: टेबल टेबल नाम बनाए ं

(. Col1. डेटा प्रकार, 

Col2 डेटा प्रकार, 

Col3 डेटा प्रकार, 

………. 

……… .. 

); 

For  example. 

Create table Emp 

( Empid integer , 

Name char(20), Desig Varchar(255) 

); 

  



सत्र 3: टेबल पर संचालन करें  

 ओपनऑतिस बेस में, हम टेबल  में डेटा स्टोर करिे हैं TABLE1 

 1) िातलका का 

चयन करें , उस पर 

डबल क्लिक करें। 

 2) टेबल डेटाशीट 

वू्य में खुलेगी।. 

 

 

 

 

       

 

 

Numeric type data are given below :  

ID COMPANY CITY EMAIL ADDRESS CONTACT 
NO. 

1 A DELHI a@gmail.com 1111111111 

2 B MUMBAI b@yahoo.co.in 3333333333 

डेटाशीट वू्य में 

आवश्यक संख्या में 

ररकॉडड डालें। 

डेटाशीट दृश्य में 

आवश्यक ररकॉडड 

संपातिि करें  

डेटा का चयन करें> 

चयतनि डेटा पर राइट 

क्लिक करें> हटाएं 

तवकल्प का चयन करें। 

डेटा प्रकार सेट के 

अनुसार फील्ड के 

तवतिन्न गुण 

ID COMPANY CITY EMAIL 
ADDRESS 

CONTACT 
NO. 

1 A DELHI a@gmail.com 1111111111 

2 B CHENNAI b@yahoo.co.in 3333333333 

3 C BANGALORE C123@gmail.com 2222222222 

4 D MOHALI d234@yahoo.co.in 5555555555 

PERFORM OPERATION ON TABLE  

टेबल पर ऑपरेशन करें  

INSERT डालना MODIFY संशोतिि

  

REMOVE तनकालना FIELD PROPERTY 

INSERT 

REMOVE 

UPDATE 

FIELD PROPERTY –TWO TYPE  (FIELD संपत्ति- दो प्रकार की) 

mailto:a@gmail.com
mailto:b@yahoo.co.in
mailto:a@gmail.com
mailto:b@yahoo.co.in
mailto:C123@gmail.com


संख्यात्मक प्रकार के आंकडे नीचे त्तदए गए हैं  

1) AutoValue - हााँ - ऑटो नू्यमेररक मान प्राप्त करें। 

2) AutoValue - नही ं- ऑटो नू्यमेररक मान नही ंतमलिा है। 

3) लंबाई - तडफॉल्ट रूप से फील्ड की लंबाई 10 है लेतकन अतिकिम लंबाई पर सेट है। 

4) तडफॉल्ट मान - एक तडफॉल्ट मान सेट तकया जा सकिा है -> यति उपयोगकिाड प्रवेश करिे समय 

कोई मान प्रिान नही ंकरिा है। 

5) Format – यह गुण के्षत्र में िजड तकए गए डेटा के प्रारूप को सेट करने में मिि करिा है। 

Character type data are shown below : 

कैरेक्टर टाइप डेटा नीचे त्तदखाया गया है: 

1) प्रतवति आवश्यक - हााँ-> मूल्य सक्लितलि करना होगा। 

2) लंबाई - तडफॉल्ट रूप से फील्ड की लंबाई 10 है लेतकन अतिकिम लंबाई पर सेट है। 

3) तडफॉल्ट मान - एक तडफॉल्ट मान सेट तकया जा सकिा है -> यति उपयोगकिाड प्रवेश करिे समय 

कोई मान प्रिान नही ंकरिा है। 

4) Format – यह गुण िील्ड में डाले गए डेटा के Format जैसे 91-222-333 को सेट करने में मिि 

करिा है। 

Sorting Data : (डेटा छँटाई ) 

छाँ टाई का अर्ड है आाँकडो ंको आरोही क्रम या अवरोही क्रम में व्यवक्लथर्ि करना। 

UNSORTED DATA 

अनसोटेड डेटा 

ASCENDING DATA 

आरोही डेटा 

DESCENDING DATA 

अवरोही डेटा 

4 1 4 

2 2 3 

1 3 2 

3 4 1 



 

Referential Integrity : संदत्तभिक समग्रता : 

ओपनऑत्तिस बेस में, प्राथत्तमक क ं जी और त्तवदेशी क ं जी की सहायता से डेटा को दो या दो से अत्तिक 

तात्तलकाओ ंके बीच जोडा जा सकता है 

संबंि में डेटा की सटीकता और स्थथरता बनाए रखने के त्तलए संदभाित्मक अखंडता का उपयोग त्तकया 

जाता है। 

AVOID (टालना) :- 

1) ररकॉडड जोडना - यति primary key िातलका में कोई संबद्ध ररकॉडड उपलब्ध नही ंहै। 

2) बिलिे मूल्य - यति संबंतिि िातलका में कोई आतिि ररकॉडड  मौजूि है। 

3) ररकॉडड हटाना - यति संबंतिि िातलका में कोई तमलान संबंतिि ररकॉडड उपलब्ध है। 

Creating and Editing Relationships between Tables : 

तात्तलकाओ ंके बीच संबंि बनाना और संपात्तदत करना : 

एक संबंि िो या िो से अतिक िातलकाओं के बीच संबंि या संबंि को संितिडि करिा है। 

िातलकाओं के बीच संबंि  को तनम्न प्रकार से समझने में मिि करिे हैं: 

1. समय बचाएं। 

2. डेटा-प्रतवति तु्रतटयो ंको कम करें। 

3. संबंतिि िातलकाओं से डेटा का सारांश करें। 

आप टूल्स मेनू्य से ररलेशनतशप तवकल्प चुनकर तकन्ी ंिी िो टेबलों के बीच संबंि बना सकिे हैं। 



 

िातलकाओ ंमें िीन प्रकार के संबंि बनाए जा सकिे हैं: 

 

 

 

 

 

 

 

Remove the Relationships 

ररश्ो ंको हटा दें 

टेबल्स पर लागू तकए गए ररश्ो ंको तडलीट ऑप्शन की मिि से िी हटाया जा सकिा है। 

राइट क्लिक, ररलेशनतशप थे्रड पर राइट क्लिक करें  और तडलीट ऑप्शन चुनें। 

  

िोनो ंिातलकाओ ंमें  

primary key सं्ति होने 

चातहए। 

िातलकाओ ंमें से एक में  

primary key सं्ति होना 

चातहए। 

तकसी िातलका में  primary 

key सं्ति नही ंहै। 

RELATION SHIP 

ONE TO ONE ONE TO 

MANY 
MANY TO 

MANY 



SESSION 4: RETRIEVE DATA USING QUERY  

जब आप कुछ जानकारी जानना चािते िैं िो हिर आप डेटाबेस से पूछताछ करते िैं। Query डेटाबेस से 

हिहिष्ट जानकारी एकत्र करने की प्रहिया िै। 

एक Query िमें हिहिन्न ताहिकाओं से जानकारी जोड़ने और उस जानकारी को ह़िल्टर करने में मदद करती िै। 

फ़िल्टर िंग का अर्थ है फक Query कुछ डेटा छछपाने के छिए आपके द्वा ा प्रदान फकए गए मानदिंड का उपयोग क ती है औ  केवि 

वही प्रस्तुत क ती है जो आप देखना चाहते हैं। 

Query भाषाएँ किं प्यूट  भाषाएँ हैं छजनका उपयोग डेटाबेस औ  सूचना प्रणािी में के्व ी बनाने के छिए फकया जाता है।  
 

Query Creation Using Wizard 

छडजाइन व्यू का उपयोग क के के्व ी का छनमाथण कुछ RDBMS के्व ी बनाने के छिए एक ग्राफ़िकि साधन प्रदान क ते हैं, िेफकन 

अछधकािंश RDBMS ऐसा नहीं क ते हैं। यहीं प  आप SQL ("सीक्वि" के रूप में उच्चार त) या स्रक्चडथ के्व ी िैंग्वेज का उपयोग 

क ते हैं। 

SQL(Structured Query Language)- के्व ीज वे कमािंड हैं छजनका उपयोग डेटा सिं चना को पर भाछषत क ने औ  

डेटाबेस में डेटा में हे फे  क ने के छिए भी फकया जाता है। 

  

SQL कमािंड का उपयोग डेटाबेस में डेटा को मैनेज औ  मैछनपुिेट क ने के छिए भी फकया जाता है। 

SQL कमािंड को इस प्रका  वगीकृत फकया गया है: 

(1)DDL statements (Data Definition Language) - डटेाबेस में छवछभन्न सिं चनाओं को पर भाछषत क ने के 

छिए डेटा पर भाषा भाषा का उपयोग फकया जाता है। 

 

(a)CREATE Command: फिएट स्टेटमेंट का उपयोग डेटाबेस या टेबि बनाने के छिए फकया जाता है। 

Syntax of CREATE Command:  

CREATE TABLE (columnName Datatype(size), columnName Datatype(size)………);  

For Example:  

CREATE TABLE St1 ( StudentID INT(10), Name VARCHAR(55), 

SQL is 
categorized

-
1) DDL 2) DML 

1)DDL 
statements 

(A) 
CREATE 

(B) 
ALTER

(C) 
DROP

2)DML 
statements

(A) 
SELECT 

(B) 
INSERT

(C) 
UPDATE

(D) 
DELETE



Address VARCHAR(60), DOB DATE , mobile(12) ); 

(b)ALTER TABLE Statement: मौजूदा ताछिका में कॉिम जोड़ने, हटाने या सिंशोछधत क ने के छिए ALTER TABLE 

स्टेटमेंट का उपयोग फकया जाता है। 

Syntax: 

ALTER TABLE tablename ADD columnname datatype ; यह 

For Example  

ALTER TABLE St1 ADD city VARCHAR(20) ; 

 

(c)DROP TABLE Statement: DROP TABLE स्टेटमेंट का उपयोग डेटाबेस में मौजूदा टेबि को ड्रॉप क ने के छिए 

फकया जाता है। 

Syntax 

DROP TABLE tablename ; 

For Example  

DROP TABLE St1 ; 

  

(2) Data Manipulation language (DML)  

यह उपयोगकताथओं को डेटाबेस में डेटा तक पहँचने औ  हे फे  क ने में सक्षम बनाता है। 

इसका उपयोग किं प्यूट  के सार् मानव सिंपकथ  प्रदान क ना है। 

यह डेटा हे फे  कमािंड उपयोगकताथ की मदद क ता है: - 

 (a)INSERT statement : इसका उपयोग डेटाबेस में एक या एक से अछधक र कॉडथ जोड़ने के छिए फकया जाता है। 
Syntax : 

INSERT INTO () VALUES ();  

For Example 

INSERT INTO St1 ( StudentID, Name, Address DOB, mobile)  

VALUES (‘19761234567’, ‘Anil’, ‘ 78,Daryaganj, New Delhi’ , ‘05/10/1976‘ 9512365690’) ;  

(B)UPDATE statement : update statement का उपयोग ताछिका में मौजूदा र कॉडथ को सिंशोछधत क ने के छिए 

फकया जाता है। 
Syntax: 

UPDATE table_name SET column1 = value1, column2 = value2, ... WHERE condition;  

For Example  

UPDATE St1 SET Address= ‘ 45, shahdara, New Delhi’ WHERE Name= ‘ Anu’ 



C) DELETE statement: छडिीट स्टेटमेंट का उपयोग डेटाबेस में एक या एक से अछधक र कॉडथ को हटाने के छिए फकया 

जाता है। छडिीट का उपयोग क के पहिे बनाई गई ताछिका में से फकसी एक र कॉडथ को हटाने के छिए 

Syntax : 

DELETE FROM WHERE;  

For Example: 

 DELETE FROM St1 WHERE Name= ‘Anil’; 

(D) SELECT Statement: डेटाबेस से डेटा का चयन क ने के छिए सेिेक्ट स्टेटमेंट का उपयोग फकया जाता है 
Syntax :  

SELECT column1,column2, ... FROM tablename ;  

Here, column1, column2, ... are the field names of the table you want to select data from.  

If you want to select all the fields available in the table, use the following syntax: 

 SELECT * FROM tablename ; 

 For Example SELECT * FROM St1 ; 

 Or  

SELECT Name, Address, mobile FROM St1; 

 

The SELECT statement has many optional clauses: 

 • WHERE specifies which rows to retrieve. 

 • ORDER BY specifies an order in which to return the rows.  

In order to execute queries click on the Queries option available on the left side under database 

section, click Create Query in SQL View as shown below. 

SQL ORDER BY Keyword:  

ORDER BY कीवडथ का उपयोग पर णाम-सेट को आ ोही या अव ोही िम में सॉटथ क ने के छिए फकया 

जाता है। ऑडथ  बाय कीवडथ र कॉडथ को छड़िॉल्ट रूप से आ ोही िम में सॉटथ क ता है। 

 
To sort the records in descending order, use the DESC keyword.  

ORDER BY Syntax SELECT column1, column2, ... FROM table_name  

ORDER BY column1, column2, ... ASC|DESC;  

For Example  

SELECT Name, Address. FROM Student ORDER BY Student_ID ASC; 

SELECT Name, Address. FROM Student ORDER BY Student_ID DESC; 

 



SQL Where Keyword:  

डेटा का समूहीक ण एक ही प्रका  के मान वािे र कॉडथ प्रदर्शथत क ने के छिए "WHERE" खिंड का चयन 

SQL कमािंड के सार् फकया जा सकता है। 

 
To get details about the list of students whose favorite color is Red, you can use: 

 select * from SDetails where Color=’Red’;  

  



SESSION 5: CREATE FORMS AND REPORTS USING WIZARD  

Forms ( िॉमि) 

Forms डेटाबेस ऑबे्जक्ट हैं तजनका उपयोग िातलका में डेटा िजड करने, संपातिि करने या खोजने 

के तलए तकया जािा है। 

CREATE a FORM (िॉमि बनाएं) 

Forms वे ऑबे्जक्ट होिे हैं तजनका उपयोग डेटा को संग्रहीि करने के तलए तकया जािा है, तजसे 

िातलका में िजड या संपातिि तकया जा सकिा है। 

CREATE FORM Using Form Wizard(िॉमि त्तवजाडि का उपयोग करके िॉमि बनाएं) 

1. डेटाबेस window के ऑबे्जक्ट सेक्शन में िॉमड तवकल्प पर क्लिक करें। 

2. टास्क तसलेक्शन में - यूज तवजाडड टू तक्रएट िॉमड चुनें 

3. िील्ड चयन - टेबल या Queryका चयन करें। 

एक सबिॉमड सेट करें। 

4. तनयंत्रण व्यवक्लथर्ि करें  - फील्ड नामो ंकी व्यवथर्ा चुनें। 

5. डेटा प्रतवति सेट करें  - डेटा प्रतवति का चयन करें  (नया या सिी डेटा) 

6. स्टाइल लागू करें  - िॉमड का रंग चुनें 

7. सेट नाम - उपयुक्त नाम िें  और तितनश बटन पर क्लिक करें  

Form बनाया गया है। 

Reports (ररपोटों) 

ररपोटड डेटाबेस ऑबे्जक्ट हैं तजनका उपयोग िातलका या के्वरी में संग्रहीि जानकारी को तपं्रट करने 

योग्य प्रारूप में प्रसु्ति करने के तलए तकया जािा है। 

CREATE REPORTS (ररपोटि बनाएँ) 

ररपोटड में िातलका/के्वरी के सिी फील्ड या फील्ड के केवल चयतनि सेट शातमल हैं। 

CREATE REPORTS Using Wizard (त्तवजाडि का उपयोग करके ररपोटि बनाएं) 

1. ऑबे्जक्ट सेक्शन में ररपोटड तवकल्प चुनें और टास्क सेक्शन में ररपोटड बनाने के तलए तवजाडड का 

उपयोग करें  पर क्लिक करें। 

2. िील्ड चयन - िातलका या के्वरी का चयन करें  तजस पर ररपोटड िैयार की जानी है और ररपोटड में 

आवश्यक फील्ड का चयन करें। अगला पर क्लिक करें  

3. लेबतलंग िील्ड - कॉलम का नाम बिलें 



4. गु्रतपंग - यति आवश्यक हो िो िील्ड पर समूह बनाएं 

5. सॉटड तवकल्प - फील्ड का चयन करें  तजसके द्वारा आप आरोही या अवरोही क्रम में ररपोटड चाहिे 

हैं 

6. लेआउट चुनें - लेआउट चुनें - ररपोटड कैसी तिखिी है 

7. ररपोटड बनाएाँ  - उपयुक्त शीर्डक िें  और समाप्त पर क्लिक करें। 

ररपोटड बनिी है। 

 

  



MCQ(objective questions):- 

1.डेटा के दोहराव को क्रकस रूप में जाना जाता है? 

(ए) डेटा ववसंगनत (बी) डेटा अनतरेक (सी) डेटा पश्चाताप (डी) इनमें से कोई नहीं 

उत्तर: डेटा अनतरेक 

2. साधारण वस्तु, ववषय या उद्देश्य के रूप में जाने जाने वाले डेटा को संग्रहीत करने वाला एक 

स्टोरेज कंटेनर 

(ए) प्रश्न (बी) तासलका (सी) ररपोटट (डी) फॉमट। 

उत्तर: टेबल 

3. एक डेटाबेस में हमेिा होना चाठहए 

(ए) छववयां (बी) बहुत सारे ररकॉडट (सी) एक प्रमुख क्षेत्र (डी) बहुत सारे तैयार क्रकए गए प्रश्न 

उत्तर: एक प्रमुख क्षेत्र 

4. जब एक प्राथसमक कंुजी में एक से अधधक क्षेत्र होते हैं तो इसे कहा जाता है 

(ए) वैकश्ल्पक कंुजी (बी) उम्मीदवार कंुजी (सी) प्राथसमक कंुजी (डी) समग्र कंुजी 

उत्तर: समग्र कंुजी 

5. उपयोगकताा पररिाहित िेआउट में एक इंटऱेिस जो उपयोगकताा को टेबि में डेटा देखने, दजा 

करने या बदिने देता िै हजसे (ए) टेबि (बी) िॉमा (सी) ररपोटा (डी) के्वरी के रूप में जाना जाता िै 

उत्तर: रूप 
6.RDBMS का मतिब___ िै। 

7.________ से्टटमेंट का उपयोग डेटाबेस में नई टेबि बनाने के हिए हकया जाता िै। 

8.____ की में यूहनक िैलू्य िो सकती िै। 

9. टेबल में ररकॉडडडस को स्टोर करने के तलए तकस डेटाबेस ऑबे्जक्ट का उपयोग तकया जािा 

है? 

a) ररपोटड    b) प्रश्न    c) िॉमड   d) इनमें से कोई नही ं

10. एक query का उपयोग करके पूवाडवलोकन तकया जा सकिा है? 

a) F1   b) F3  c) F5   d) F7 

11. िील्ड कंस्टर ेंटडस को लागू करने के तलए तकस SQL कमांड का उपयोग तकया जािा है? 

a) एल्टर   b) संशोतिि करें    c) डर ॉप    d) संपातिि करें  

 



Subjective questions:- 

1.सारणणयों के बीच संबधं स्थावपत करने की क्ट्या आवश्यकता है? 

2. सामान्य फाइल ससस्टम की तुलना में DBMS के क्ट्या लाभ हैं? 

3. डेटा अनतरेक का क्ट्या अथट है? 

4. उदाहरण की सहायता से तासलका में ररकॉडट और फील्ड के बीच अंतर करें। 

5. डेटाबेस को उदाहरण सठहत स्पष्ट कीश्जए। 

6. ववदेिी कंुजी और प्राथसमक कंुजी में क्ट्या अंतर है? 

7. डेटाबेस में टेबि बनाने के चरण हिखखए 

8. ताहिका, पंखि, सं्ति को पररिाहित करें 

9. बेस सॉफ्टिेयर के नाम में प्रयोग िोने िािे कोई तीन बेहसक डाटा टाइप हिखखए। 

10. कोई दो डीबीएमएस सॉफ्टिेयर हिखखए 

11. िॉमड ररपोटड से तकस प्रकार तिन्न हैं? 

12. क्या हम अनेक लेबलो ंका उपयोग करके िॉमड या ररपोटड बना सकिे हैं? 

13. डेटाबेस में query बनाने का उदे्दश्य क्या है? 

 

  



प्रश्न एवं उिर 

प्रश्न 1 : िॉमड से आप क्या समझिे हैं ? 

उत्तर 1: िॉमड उपयोगकिाड को सीिे उस िातलका में डेटा िेखने, िजड करने या बिलने िेिा है। 

प्रश्न 2 : ररपोटड क्या है? 

उत्तर 2: एक ररपोटड मुतिि प्रारूप में डेटा प्रसु्ति करने का एक प्रिावी िरीका है। 

प्रश्न 3 : ररपोटड बनाने का उदे्दश्य क्या है? 

उत्तर 3: एक ररपोटड संके्षप में प्रितशडि करने में मिि करिी है। इसका उपयोग स्पि प्रारूप में समग्र 

कायड पररणाम उत्पन्न करने के तलए तकया जािा है। 

प्रश्न 4 : क्या आप Query से डेटा तिखा/प्रितशडि कर सकिे हैं? 

उत्तर 4: हााँ, हम Query से डेटा तिखा/प्रितशडि कर सकिे हैं। 

प्रश्न 5 : एक डेटाबेस में िॉमड और ररपोटड तकिने िरीको ंसे बनाए जा सकिे हैं? 

उत्तर 5: िॉमड 

तडजाइन दृश्य - ररकॉडड स्रोि, तनयंत्रण और तनयंत्रण तनतिडि करिे हुए एक िॉमड 

बनाएाँ  गुण। 

तवजाडड - तवजाडड आपको फॉमड बनाने के तलए आवश्यक चरणो ंके माध्यम से 

मागडिशडन करेगा 

ररपोटड - 

तवजाडड - तवजाडड आपको ररपोटड बनाने के तलए आवश्यक चरणो ंके माध्यम से मागडिशडन करेगा। 

 

 

 

 

  



Competency based questions 

Solved Queries 

Q1: To display the salary of all the employees after incrementing by 1000 then the foll1`owing SQL 

command will be executed in Base SQL Design 144 

 Ans. Select “EmployeeID”, “FirstName”, “Salary” +1000 from “Employee”; 

Q2:To display the salary of all the employees after decreasing by 10000 then the following SQL 

command will be executed in Base SQL Design  

Ans.Select “EmployeeID”, “FirstName”, “Salary” - 10000 from “Employee”; 

Q3:To display the salary of all the employees after incrementing it as twice the amount of present 

salary, then the following SQL command will be executed in Base SQL Design. 

 Ans.Select “EmployeeID”, “FirstName”, “Salary” * 2 from “Employee” ; 

 Q4.To display half of the salary amount paid to the employees, then the following SQL command 

will be executed in Base SQL Design.  

Ans.Select “EmployeeID”, “FirstName”, “Salary”/2 from “Employee”; 

Q5.To view records in ascending order of RollNo, from the table the select statement will be: 

 Ans. select * from SDetails order by “Rollno” ASC;  

 Q6.To retrieve all the columns in a table the syntax is:  

 Ans.SELECT * FROM tablename; 

Q7.change location of roll no=14 to bhubanewar. 

Ans.Update SDetails set Location = ‘Bhubaneswar’ where Rollno = 14;  

8. अनन्या ने अपने काम से जुडे़ डेटा को कई िाइिो ंमें स्टोर हकया। उसे इस बात का अिसास निी ंथा हक 
एक मित्वपूणा चीज से संबंहित एक िी डेटा को तीन अिग-अिग िाइिो ंमें अिग-अिग संग्रहित हकया गया 
था। यि अनन्या के हिए एक बड़ी समस्या का कारण बन गया जब उसने अन्य ़िाइिो ंको अपडेट करने के 
हिए िूि जाने के दौरान उस डेटा को एक ़िाइि में संिोहित हकया (ए) असंगहत (बी) अहतरेक (सी) 
मानकीकरण (डी) इनमें से कोई िी समस्या निी ं

उत्तर: असंगहत 
 

 



UNIT-4 WEB APPLICATIONS AND SECURITY 

 

SESSION 1: WORKING WITH ACCESSIBILITY OPTIONS(अभिगम्यता विकल्पों के साथ काम करना) 

SESSION 2: NETWORKING FUNDAMENTALS(नटेिर्किं ग की बुननयादी बाते) 

SESSION 3: INTRODUCTION TO INSTANT MESSAGING(इंस्टेंट मैसेज ंग का परिचय) 

SESSION 4: CHATTING WITH A CONTACT – GOOGLE TALK (जकसी संपकक  के साथ चैट किना) 

SESSION 5: CREATING AND PUBLISHING WEB PAGES – BLOG(वेब पे  बनाना औि प्रकाजित किना - ब्लॉग ) 

 SESSION 6: USING OFFLINE BLOG EDITORS (ऑफ़लाइन ब्लॉग संपादक  ंका उपय ग किना) 

SESSION 7: ONLINE TRANSACTIONS(ऑनलाइन लेनदेन) 

SESSION 8: INTERNET SECURITY (इंटिनेट सुिक्षा) 

SESSION 9 : MAINTAIN WORKPLACE SAFETY(कायकस्थल सुिक्षा बनाए िखें ) 

SESSION 10: ACCIDENTS AND EMERGENCIES (दुर्कटनाएं औि आपात स्स्थजत) 

SESSION 11: HAZARDS AND SOURCES OF HAZARDS(खति  ंऔि खति  ंके स्र त) 

 

 

 



SESSION 1: WORKING WITH ACCESSIBILITY OPTIONS 

  (अभिगम्यता भिकल्पों के साथ काम करना) 

अभिगम्यता सिी के भिए एक कंप्यूटर भसस्टम की उपयोगकताा भमत्रता को संदभिात करती है। 

प्रौद्योगिकी जो गिकल ांि व्यक्ति को आस नी से कां पू्यटर क  उपयोि कर के सक्षम बनाने में मदद करती है 
यह सह यक तकनीक है। भिकार के प्रकार:- 

 

                                       

सुलिता विकल्पों को लॉन्च र्कया जा रहा है     

स्टाटट - कंट्रोल पैनल - एक्सेभसबबभलटी विकल्प                 

यहााँ हमें निम्िभिखित टैब भमिते हैं। 

कीबोर्ट टैब: 

1. स्स्टकी की—शारीररक अक्षमताओं वािे उपयोगकतााओं को दोहराव वािे तिाव को कम करिे में मदद 
करती हैं। 

2. र्िल्टर कंुस्जयां- हाथ कापंिे वािे िोगों के भिए टाइपपगं को आसाि बिािा (बार-बार स्रोक को 
अिदेिा करें)। 

3. टॉगल कंुस्जयााँ-- यह दृष्टट दोष वािे व्यष्तत या संज्ञािात्मक अक्षमताओं के भिए डिजाइि की गई 
है। 

ध्िनन टैब: 

1. ध्िनन संतरी: श्रवण हानि वािे उपयोगकतााओं की सहायता करें। यह दृश्य चेताविी उत्पन्ि 
करता है। 

2. ध्िनन ददखाएाँ: यह ध्वनि द्वारा जािकारी प्रदाि करता है और दृष्टटगत जािकारी िी प्रदाि 
करता है। 

प्रदर्टन टैब: 

वि
का
र 
के 
प्रक
ार

संज्ञानात्मक (यह 
सीखने की हानन है)

डिस्िेष्तसया, 
ऑटटज्म

तस्िीर/(कम दृस्टट
हानन)

पूणा आभंशक या रंग 
अंधापि।  

सुनिाई (बहरापन)

मोटर/(र्ारीररक 
हानन)

पक्षाघात, सेरेब्रि 
पाल्सी।  



1. दृष्टटबाधधत व्यष्तत के भिए उच्च कंरास्ट। 
2. कसार पवकल्प ष््िंक दर और कसार की चौडाई बदि रहा है। 

माउस टैब /माउस कीज़: ष्जि िोगों को माउस का उपयोग करिे में कटििाई होती है, यह उि िोगों की 
मदद करता है जो माउस की तरह कीबोिा के िबंरपैि का उपयोग करते हैं। 

सामान्य टैब: इसमें सीररयि क ं ष्जयों जैसे सिी उपयोगकतााओं के भिए एतसेभसबबभिटी पवकल्प हैं। 

              

SESSION 2: NETWORKING FUNDAMENTALS(नेटिभकिं ग बुभनयादी बातप ों) 

कंप्यूटरों का वह संग्रह जो सूचिाओं और संसाधिों को आपस में साझा करिे के भिए आपस में ज डे होते हैं,   

कंप्यूटर िेटवका  कहिाते हैं। नेटिकक  आभकक टेक्चर:- 

 

• नेटिकक  के प्रकार:- 

नेटिकट  आर्कट टेक्चर

पीयर टू पीयर (P2P)

िेटवका  ष्जसमें सिी 
कंप्यूटरों को सीपीयू सक्षम 
की समाि और समाि 

ष्स्थनत होती है।

क्लाइंट सिटर आर्कट टेक्चर

सवार: अन्य कंप्यूटरों को 
सेवाएं प्रदाि करता है।

ग्राहक: सवार द्वारा प्रदाि 
की जािे वािी सेवाओ ंका 

उपयोग करें।



 

                                

 

 

 

इंटरनेट: इांटरनेट एक ऎसा नेटिकक  है जो सभी परस्पर जुडे कां पू्यटरोां के बीच सूचन  स झ  करने में समर्थ है 

WWW: यह वल्िा वाइि वेब या w3 है ष्जसे वेब के िाम से िी जािा जाता है। इसमें कई हाइपरभिकं ज डे वेब 
पेज शाभमि हैं। इि वेब पेजों में टेतस्ट वीडियो एनिमेशि हैं 

िेब ब्राउजर: यह एक सॉफ्टवेयर है जो वेबसाइटों को िोििे में मदद करता है। उदाहरण के भिए: 
फायरफॉतस, ओपेरा भमिी, इंटरिेट एतसप्िोरर, िटेस्केप िेपवगेटर इत्याटद। 

नेटिर्किं ग के लाि: 

 

अतः हम कह सकते हैं कक िटेवका  की सहायता से आपस में ज डे ह ए कम्प्यूटरों में ककसी िी प्रकार के िाटा 
या हािावयेर को साझा ककया जा सकता है। 

इंटरनेट तक पहंुच प्राप्त करना: 

नेटिकट  के प्रकार:

लैन (लोकल एररया
नेटिकट )

यह सीभमत िौगोभिक 
काि क्षेत्र जैसे गहृ 
पवद्यािय कायाािय 
िवि में प्रयोग होिे 
वािा िेटवका  है।

मैन (मेट्रोपॉभलटन 
एररया नेटिकट )

यह केबि टीवी, 
रेडियो िेटवका  जैसे 
एक शहर का िेटवका
है। रेंज िगिग 100

ककमी।

िैन (िाइर् एररया 
नेटिकट )

यह वह है जो एक 
व्यापक क्षेत्र को कवर 
करता है। उपग्रह और 

च ंबकीय तरंगों का उपयोग 
कर सूचिाएं साझा कर

रहे हैं

पैन (पसटनल एररया
नेटिकट )

यह ्िूटूथ स्पीकर, 
टीवी ररमोट, एसी 
ररमोट, पप्रटंर आटद 
की तरह एक कमरा 
या बह त पास है।

र्ेटा साझा करना दस्तािेज हस्तांतर हार्टिेयर साझा करना इंटरनेट एक्सेस 
रे्यररंग

नेटिकट  आधाररत
एस्प्लकेर्न का 
उपयोग



इंटरिटे का उपयोग करिे के भिए हमें आईएसपी (इंटरिटे सेवा प्रदाता) द्वारा प्रदाि ककए गए इंटरिेट 
किेतशि की आवश्यकता होती है। 

आईएसपी बीएसएिएि, ष्जयो, एयरटेि, वोिाफोि इत्याटद जैसे एक संगिि है, ष्जन्हें इंटरिटे सेवाएं प्रदाि की 
जाती हैं। 

मोर्म 

यह एक ऐसा उपकरण है जो डिष्जटि भसग्िि को एिािॉग भसग्िि में पररवनतात करता है और इसके पवपरीत। 
ये भसग्िि फोि िाइिों पर यात्रा कर सकते हैं। मॉिम का फ ि फॉमा मॉड्य िेटर और िेमोि िेटर होता है। 

सामान्य इंटरनेट कनेस्क्टविटी के प्रकार: 

 

िायि अप किेतशि बेहद धीमे हैं। इसभिए किेतशि को गनत देिे के भिए हम िीएसएि और केबि मॉिम 
इंटरिटे एतसेस का उपयोग करते हैं। 

3G: यािी तीसरी पीढी यह Wimax या Wi-Fi से तीि ग िा धीमी है। 

वाईमैतस: यह ि िा 

1. इंटरनेट पर र्ेटा ट्रांसिर: 
2. िेटा को इंटरिेट पर पैकेट के रूप में स्थािांतररत ककया जाता है। 
3. प्रत्येक पकेैट को तब तक िेजा जाता है जब तक कक उसे अपिा गंतव्य िहीं भमि जाता। एक सकिय 

प्रवेश करता है 
4. गंतव्य पर ये पकेैट पवूा हैं 

इंटरिटे का उपयोग करिे के भिए हमें सकिय इंटरिटे किेतशि की आवश्यकता होती है। 

SESSION 3: INTRODUCTION TO INSTANT MESSAGING 

सत्र 3: इंस्टेंट मैसेज ंग का परिचय 

 इंस्टेंट मैसेज ंग (आईएम) पे्रषक से रिसीवि तक टेक्स्ट-आधारित संदेश  ंके इंटिनेट पि संचाि का एक रूप है.  

 

 

 

 

 

वायिा (िायि अप, िीएसएि, 
केबि इंटरिेट एतसेस) तार रटहत (3जी, वाइमैतस, 

वाईफाई)

इंस्टेंट मैसेज ंग सॉफ्टवेयि (मुख्य जविेषताएं) 
1. पाठ संदेश एक या अजधक ल ग  ंक  भे े  ा सकते हैं। 

2. ऑजिय  कॉजलंग औि कॉन्फ्रें जसंग। 

3. वीजिय  कॉजलंग औि कॉन्फ्रें जसंग। 

4. फाइल स्र्ानांतिण (उदाहिण के जलए - दस्तावेज़, से्प्रिशीट, ऑजिय  फाइलें, वीजिय  

फाइलें, आजद) 

5. संदेश इजतहास (भजवष्य के संदभथ के जलए संदेश सहे ें)। 



 

   

 

 

 

 

 

 

 

 

 

 

Creating An Instant Messaging Account  

• उपय गकताथ के कंपू्यटि पि िाउनल ि औि 

इंस्टॉल जकया गया। 

 
1. Google Talk 
2. Yahoo! Messenger 
3. Skype 
4. Windows Live Messenger 

5. Rediff Bol, etc. 

• nternet Explorer, Mozilla Firefox, Google 

Chrome, आजद  ैसे ब्राउज़ि  ंका उपय ग 

किके एके्सस जकया गया। ल कजप्रय सॉफ्टवेयि 

नीचे के रूप में:- 

 
1. Meebo 
2. Yahoo! Messenger for the Web 
3. MSN Web Messenger 
4. IMO, etc. 



एक त्वरित संदेि खाता बनाना

 

 

* You need to download Google Talk Application 

आपक  Google Talk एस्िकेिन डाउनल ड किने की आवश्यकता है 

• अपने Gmail account  में साइन इन किना 

• Google Talk लॉन्च किना 

 
Click→Start→Google Talk →Google Talk 

Or 
Double click on Google Talk ICON (if available on Desktop) 
See a window similar to the one displayed below:- 

  
   
 

 

 

➢ आपके पास संपकों की सूची ह नी चाजहए। 

➢ यजद आपके पास संपकथ  की सूची नही ंहै 

(आमंत्रण भे कि उनके Gmail account क  अपनी संपकथ  सूची में   डें) 

 

  
 

SESSION 4: CHATTING WITH A CONTACT – GOOGLE TALK 

सत्र 4: जकसी संपकक  के साथ चैट किना – GOOGLE TALK 

GOOGLE TALK

त्िररत संदेर् सेिा ननिःर्ुल्क है और यह एस्प्लकेर्न-
आधाररत और िेब-आधाररत के रूप में उपलब्ध है

TEXT

VOICE 
MESSAGING

VIDEO CALLING

 



Steps to Chat with a contact that is already added to your contact list. 

आपकी संपकक  सूची में पहले से   डे गए संपकक  के साथ चैट किने के चिण। 

➢ आपक  उन संपकों की सूची बनानी चाजहए    चैट के जलए उपलब्ध हैं। यजद आपके पास क ई संपकथ  नही ंहै, त  

आप आमंत्रण भे कि उनके Gmail खाते क  अपनी संपकथ  सूची में   ड सकते हैं। 

➢ संपकथ  नाम पि िबल क्लिक किके चैट किने के जलए संपकथ  ख  ें। 

➢  ब भी संपकथ  सूची में आपका जमत्र ऑनलाइन ह ता है त  आप हिे जबंदु के सार् उस व्यक्लि क  देख सकते हैं। 

➢ आप जकसी संपकथ  पि िबल-क्लिक किके तुिंत टेक्स्ट चैट संदेश भे ना शुरू कि सकते हैं, दूसिा व्यक्लि टेक्स्ट 

संदेश देखेगा औि आपके संदेश का  वाब देगा।

 

General rules and etiquettes to be followed while chatting : 

चैट किते समय पालन जकए  ाने वाले सामान्य जनयम औि जशष्टाचाि 

 

 

CHATTING ON GMAIL 

संदेश संक्षक्षप्त 
और बबदं  तक
होिे चाटहए।

यटद आपका स्िीि िाम इसे 
प्रनतबबबंबत िहीं करता है तो हमेशा 

िाम से अपिा पररचय दें।

हमेशा पछूें  कक तया दसूरे व्यष्तत 
के पास पहिे चैट करिे का 

समय है।

अपिे सदेंशों को अपरकेस में
टाइप ि करें तयोंकक यह बेहद 

असभ्य िगता है - इसे धचल्िािा 
और बह त आिामक मािा जाता 

है.

िोगों को जवाब देिे का
समय दें।



GMAIL पि चैजटंग 

एक बाि  ब आप अपने  ीमेल अकाउंट में साइन इन कि लेते हैं। 

 

एक संपकथ  जवंि  प्रदजशथत की 

 ाएगी। संपकथ  के नाम पि िबल 

क्लिक किें। 

 आपक  ऐसा ही एक पॉप-अप 

जदखाई देगा 

 

वह संदेश टाइप किना प्रािंभ किें  

ज से आप भे ना चाहते हैं औि 

दूसिा संपकथ  आपके चैट संदेश 

का  वाब देने में सक्षम ह ना 

चाजहए। 

 
  

 

CHATTING ON YAHOO 

YAHOO पि चैजटंग 

➢ इससे पहले जक आप Yahoo! का उपय ग किना प्रािंभ किें ! मैसें ि, याहू मेल खाते की आवश्यकता है। 

➢ आपक  Yahoo! िाउनल ि औि इंस्टॉल किने की आवश्यकता ह  सकती है। 

http://in.messenger.yahoo.com/download/ से मैसें ि एक्लिकेशन 

➢ आपक  उन संपकों की सूची बनानी चाजहए    चैट के जलए उपलब्ध हैं। यजद आपके पास क ई संपकथ  नही ंहै, 

त  आप आमंत्रण भे कि उनके Yahoo मेल खाते क  अपनी संपकथ  सूची में   ड सकते हैं। 

➢ संपकथ  नाम पि िबल क्लिक किके चैट किने के जलए संपकथ  ढंूढें  औि जिि आप संदेश भे  औि प्राप्त कि 

सकते हैं। 

न ट:  ीमेल के समान - याहू मेल से साइन इन किें  

आप अन्य चैट सेवाओं  ैसे MSN, Rediff, Sify, आजद का उपय ग किने का भी प्रयास कि सकते हैं। 

 

 

 

 

 

SESSION 5:CREATING AND PUBLISHING WEB PAGES: BLOGS 

(वेब पे  बनाना औि प्रकाजित किना - ब्लॉग ) 



 ब्लॉि के ब रे में एक सांगक्षप्त गििरण: 

ब्लॉग सेवाएं प्रदान करने वाली वेबसाइटें- 

   
एक ब्लॉग खाता बनाना- 

ब्लॉग का उपयोग शुरू करने से पहले, एक ब्लॉग खाते की आवश्यकता होती है। एक बनाने के ललए, आपको एक वेब ब्राउज़र और 

एक इंटरनेट कनेक्शन की आवश्यकता होगी। ऑफ़लाइन या ऑनलाइन ब्लॉग के ललए इसी तरह से खाते बनाए जा सकते हैं। 

ब्लॉग अकाउंट खोलने की प्रक्रिया इस प्रकार है- 
• वेब ब्राउज़र खोलें। 
• एड्रेस बार पर वेबसाइट का एड्रेस टाइप करें। 

• अब आपको फ़ील्ड वाले पृष्ठ पर पहंचना चालहए 
• ब्लॉग का पता- आपको अपने ब्लॉग के ललए एक लवलशष्ट पता देना होगा। 

यह वह पता है लजसका उपयोग अन्य लोग आपका ब्लॉग देखने के ललए करेंगे 
• उपयोगकताा नाम- इस ब्लॉग के प्रबंधन के ललए उपयोगकताा नाम लनर्दाष्ट करें। 
• पासवडा- एक मजबूत पासवडा के साथ अपने ब्लॉग खाते को सुरलित करना 

 कुछ अंकों के साथ अपरकेस और लोअरकेस अिरों का संयोजन 
 प्रतीक एक मजबूत पयााप्त पासवडा होगा। 
 आपको दो बार पासवडा दजा करना होगा। 

क छ िोकपप्रय म फ़्त ्िॉग हैं-
www.wordpress.com

www.blogger.com

www.blog.com

www.weebly.com

www.blogsome.com

क छ िोकपप्रय सश ल्क ्िॉग हैं-
fiverr

writeraccess

problogger

list verse

upwork

B
L
O

G
S

1. व्यष्ततगत वेबपेज

2. बडा टहस्सा वेब पटृि
(ऑििाइि के समाि 
व्यष्ततगत िेयरी)

3.संदेश संदेश 

4.ऑििाइि/ऑफिाइि ्िॉग

5. फ्री/पेि ्िॉग्स- आय 
उत्पन्ि करें- ऑफर पेि 
राइटटंग असाइिमेंट जो द्वारा 
कमीशि ककया गया है ब्रांि।

B
L
O

G
S

 U
S

E
D

 F
O

R यात्रा प्रभसद्ध स्थाि 

समीक्षाएं 

समाचार कायािम /

िाइव कायािम

स्वास््य उपय ततता 

कहानियों 
श्रव्य दृश्य छपव 

जंगिी जीवि

प्रेरक िोजि 

प्रभसद्ध फैशि / डिजाइि 

च टक िे / उद्धर

R
E

Q
U

IR
E

M
E

N
T

S

  वेब ब्राउजर

सकिय इंटरिेट 
किेतशि



• ईमेल पता- आपको यहां अपना ईमेल पता देना होगा। एक सक्रियण ललंक होगा 
• "ब्लॉग बनाएँ" पर लक्लक करने के बाद आपको ब्लॉग वेबसाइट से भेजा जाता है। 
• भाषा- आप दी गई सूची में से ब्लॉलगंग के ललए अपनी भाषा चुन सकते हैं। 

• अपने सभी लववरण सही-सही भरें। 
• आपके ब्लॉग खाते को सक्रिय करने और सत्यापन के ललए ईमेल खाते पर ललंक भेजा जाता है। 
•  ब्लॉग बनाएं पर लक्लक करें. 
•  ब्लॉग खाता बनने के बाद आपको ललखना होगा और क्रिर आम जनता के ललए पोस्ट/प्रकालशत करना होगा।  

 

 

SESSION 6: USING OFFLINE BLOG EDITORS 

(ऑफ़लाइन ब्लॉग संपादक  ंका उपय ग किना) 

यक्रद कोई इंटरनेट कनेक्शन नहीं है, तब भी आप ब्लॉग एलललकेशन का उपयोग करके ब्लॉग बना सकते हैं और इंटरनेट 

कनेलक्टलवटी उपलब्ध होने पर ब्लॉग अपलोड कर सकते हैं। 
कई मुफ्त ऑफ़लाइन ब्लॉग संपादक उपलब्ध हैं लजन्हें स्थानीय कंलयूटर पर डाउनलोड और इंस्टॉल क्रकया जा सकता है जैसे- 

 

 

ऑफ़लाइन या ऑनलाइन ब्लॉग के ललए इसी तरह से खाते बनाए जा सकते हैं। 
ऑफ़लाइन ब्लॉग में एलललकेशन सॉफ़्टवेयर को डाउनलोड करने की आवश्यकता है। उपयोगकताा ऑफ़लाइन मोड में काम 

करता है। दस्तावेज़ तैयार होने के बाद अपलोड क्रकए जा सकते हैं। यह वतानी या व्याकरण संबंधी गललतयों की संभावना को 

कम करता है। शब्द सीमा का ध्यान रखा जा सकता है। ऑलडयो/वीलडयो का कई बार पूवााभ्यास क्रकया जा सकता है। 
  

Qumana Ecto BlogJet Windows Live Writer Blogdesk



SESSION 7 ONLINE TRANSACTION(ऑनलाइन लेनदेन) 

ऑनलाइन अनुवाद कंपू्यटि के नेटवकथ  के माध्यम से धन का हस्तांतिण है 

ऑनलाइन लेन-देन ने लेन-देन क  आसान, सुजवधा नक औि सिल बना जदया है 

कुछ ऑनलाइन लेनदेन उदाहिण 

1.एटीएम मशीन लेनदेन -  मा, जनकासी 

2. जबल भुगतान या बा ाि भुगतान िेजबट या के्रजिट कािथ या इंटिनेट बैंजकंग या यूपीआई द्वािा 

(एकीकृत भुगतान इंटिफेस) 

Benefit Of Online Transaction (ऑनलाइन लेनदेन का लाभ) 

1. तेज़ लेन-देन 

2. सुजवधा 

3. च िी का कम   क्लखम 

Threats (Cybersecurity risks) (धमकी - साइबि सुिक्षा   क्लखम) 

1. हैजकंग औि कै्रजकंग 

2.जफजशंग -  ालसाज़  ंसे नकली ईमेल या टेक्स्ट संदेश। 

कुछ वेबसाइटें    ऑनलाइन लेन-देन की अनुमजत देती हैं 

1.www.irtc.co.in 

2.www.flipkart.com 

3.www.amazon.com 

4.www.redbus.com 

5.www.domino.com 

 

SESSION 8 : INTERNET SECURITY(इंटिनेट सुिक्षा) 

इंटिनेट सुिक्षा (Internet security) में ब्राउज़ि सुिक्षा औि नेटवकथ  सुिक्षा शाजमल है 

कई ऑनलाइन खतिे कंपू्यटि क  असुिजक्षत बनाते हैं। 

सुिक्षा के जलए सवोत्तम अभ्यास 

1.म बूत पासविथ का प्रय ग -    अल्फानू्यमेरिक औि जवशेष वणों का संय  न है 

2. एक्लन्फ्क्रप्शन सॉफ़्टवेयि का उपय ग किें  - जिज टल  ानकािी उदाहिण के जलए अनजधकृत पहुँच 

क  ि कने के जलए। कुल्हाडी तहखाना। 

3. यूज़िनेम औि पासविथ शेयि न किें  

4. पं ीकृत वेबसाइट  ंका ही उपय ग किें। 



5. व्यक्लिगत  ानकािी साझा न किें। 

6. अपने िेटा का बैकअप लें। 

7. सुिक्षा लेनदेन - ऑनलाइन बैंजकंग पि के्रजिट कािथ का उपय ग किते समय वेबसाइट का वैध 

रूप से बीमा किें। 

8. िायि वॉल स्र्ाजपत किें  - िायि वॉल आपके कंपू्यटि औि अन्य कंपू्यटि जसस्टम के बीच सेतु 

का काम किती है ज ससे आप िेटा प्राप्त कि िहे हैं 

9. एंटीवायिस औि एंटीस्पायवेयि सॉफ़्टवेयि का उपय ग किें। उदाहिण- Quick Heal, 

Kaspersky 

10. अज्ञात स्र त  ंसे सॉफ़्टवेयि कभी भी इंस्टॉल न किें। 

11. ब्राउ ि कुकी  क  बाि-बाि साि किें। 

 

Session 9: Maintain work place Safety(कायकस्थल सुिक्षा बनाए िखें ) 

FIRE SAFETY RULES 

• आग से बचिे की योजिा उधचत स्तर पर स्थापपत की जािी चाटहए। 
• नियभमत रूप से अभ्यास करें। 
• ध आाँ अिामा उधचत अंतराि पर िगाए जािे चाटहए 
•  कायास्थि को धूम्रपाि क्षते्र के रूप में जािा जाता है। 
• स रक्षा उपकरणों का नियभमत रिरिाव। 
  

FALLS AND SLEEPS SAFETY RULES 

• चिि-ेकफरिे की जगह को साफ और अव्यवस्था म तत रिें। 
• कायास्थि उधचत रूप से हवादार होिा चाटहए। 
• बबिा कफसिि वािे जूते पहिें। 
• फशा साफ और सूिा होिा चाटहए। 
• तेि, छिकती धूि त रंत साफ होिी चाटहए। 
 

ELECTRICAL SAFETY RULES 

• उपयोग ककए गए पवद्य त उपकरण मान्यता प्राप्त संगिि द्वारा अि मोटदत होिे चाटहए। 
• क्षनतग्रस्त और ितरिाक बबजिी के उपकरणों को बदिा जािा चाटहए। 
• श्रभमकों को बबजिी के उपकरणों को स रक्षक्षत रूप से संिाििे के भिए प्रभशक्षक्षत ककया जािा चाटहए। 
• सकका ट का ध्याि रिें, यह अनतिाररत िहीं होिा चाटहए। 
• गमी से निकििे वािे उपकरणों को बबजिी के उपकरणों से दरू रििा चाटहए। 



 

 

 

 

RULES OF FIRST AID 

• घायिों को शांत रहिे का आश्वासि दें। 
• अगर वे सदमे में हैं तो उन्हें गमा रिें। 
• पीि/गदाि में चोट िगिे की ष्स्थनत में पीडडत को टहिाएाँ िहीं। 

 

SESSION 10: ACCIDENTS AND EMERGENCIES (दुर्कटनाएं औि आपात स्स्थजत) 

Accident: एक द घाटिा एक अनियोष्जत घटिा है जो अचािक हो सकती है 

Types of Accidents 

• कायास्थि पर द घाटिाएाँ। 
• औद्योधगक रोग/बीमारी 
• सडक यातायात द घाटिाए ं
• िैदानिक द घाटिाएाँ 
• िेि संबंधी द घाटिाएाँ 
 

Handling Accidents and Emergency 

• प्रत्यके संगिि को द घाटिा से निपटिे के भिए एसओपी (मािक संचािि प्रकिया) का पािि करिा चाटहए। 
• कायास्थि द घाटिाओं को रोकिे के भिए स रक्षा उपाय ककए जािे चाटहए। 
• ककसी िी चोट के भिए त रंत मेडिकि टीम को ब िाएं। 
•सतका  रहो। आपातकािीि अभ्यासों पर ध्याि दें और उिका पािि करें। 

 

Handling accident at home 

• ष्जतिी जल्दी हो सके उधचत प्राथभमक धचककत्सा प्रदाि करें। 
• अगर द घाटिा बडी है तो एम्ब िेंस को त रंत कॉि करें। 
• धचककत्सा सहायता उपि्ध कराएं। 
 

3P’s  of handling accidents 

Preserve life: आपका औसत िक्ष्य व्यष्तत को जीपवत रििा होिा चाटहए। 

Prevent further injury: घायि व्यष्तत को स रक्षक्षत रिें और अब घायि होिे से बचाएं। 



Promote recovery: ष्जतिा हो सके उिकी चोटों को िीक करिे की कोभशश करें। 

 

Handling accidents at workplace  
 
• तत्काि जोखिम से निपटिे के भिए आवश्यक कारावाई करें जैसे कक प्राथभमक उपचार, आग को अिग करिा, 
क्षेत्र को बंद करिा आटद। 
• आवश्यक जांच की मात्रा और प्रकार का आुँकलन करें। 
• जााँच-पडताि करें-पता िगाएाँ कक तया ह आ और तयों ह आ। 
• ऐसा क छ दोबारा होिे से रोकिे के भिए कदम उिाएं। 
• जािमाि के ि कसाि पर िी िजर 

 

Emergency: कोई िी अप्रत्याभशत ष्स्थनत ष्जस पर तत्काि ध्याि देिे और कारावाई करिे की आवश्यकता 
है। 

 

Types of Emergency 

रसायि फैि जाता है 
• सूिा 
• आतंकी हमिा 
• पािी की बाढ 
• अत्यधधक गमी की िहरें 
• महामारी 
• आग 
• आंधी 
• गैस/रसायिों का ररसाव 

 

Session 11: Hazards and Sources of Hazards(खति  ंऔि खति  ंके स्र त) 

ितरा ककसी चीज या ककसी पर संिापवत ि कसाि, हानि या प्रनतकूि स्वास््य प्रिावों का कोई स्रोत है। 
कायास्थि के ितरे स्रोतों की एक पवस्ततृ श्रृंििा से आ सकते हैं उदाहरण के भिए कोई िी पदाथा, सामग्री, 
प्रकिया, अभ्यास ष्जसमें ककसी व्यष्तत या संपपि को ि कसाि या प्रनतकूि स्वास््य प्रिाव पदैा करिे की क्षमता 
है। 

 

General Evacuation Procedure 

• आग का अिामा बजाएं और इमारत से बाहर निकि जाएं। 



• शांत रहें और घबराएं िहीं। 
• यटद समय अि मनत देता है, तो ककसी िी ितरिाक उपकरण या प्रकिया को बदं कर दें। 
• सीटढयों और निकटतम निकास का उपयोग करके इमारत को िािी करें। 
• आग िगिे के दौराि भिफ्ट का इस्तेमाि ि करें। 
• ककसी स रक्षक्षत स्थाि और दरूी से 100 या 112 िायि करें और आपात ष्स्थनत और उसके स्थाि के बारे में 
जािकारी दें। 
• पवकिांग व्यष्ततयों के भिए, उिकी सहायता करें। 
• आपातकािीि कभमायों द्वारा अधधकृत ककए जािे तक इमारत में कफर से प्रवेश ि करें। 
• यटद आप देिते हैं कक िोग सदमे में हैं, तो उन्हें शांत करें। 
• िविों के सिी निकास स्थािों से पररधचत हों। 
• निकासी के अिामा को किी िजरअदंाज ि करें। 
  



 

मूल्ांकन:- 

1. आईएसपी क  पूणक रूप___। 

2. ि यर्क कनेक्शन के प्रक र हैं---------------------------। 

3. िेब पेजोां को खोजने के गलए उपयोि गकए ज ने ि ले सॉफ्टिेयर को ______ कह  ज त  है। 

4. ______________ इलेक्लरि क कॉमसथ का एक रूप है    ग्राहक  ंक  इंटिनेट पि सीधे जवके्रता 

से सामान या सेवाएं खिीदने की अनुमजत देता है। 

5.  ______________ का अर्थ है इंटिनेट पि सामान बेचना औि खिीदना। 

a) ई-शॉजपंग     b) ई-कॉमसथ     c) इंटिनेट 

6. COD का पूणथ रूप ______ है 

a) Card on delivery b) Cash on delivery c) Cash on document 

7.  ऑनलाइन लेन-देन की अनुमजत देने वाली जकन्ी ंद  वेबसाइट  ंकी सूची बनाएं। 

8.  ___________ एक दुभाथवनापूणथ प्र ग्राम है    आपके कंपू्यटि जसस्टम िाइल  ंपि हमला किता है। 

9. ___________, ___________, ___________, ___________, ___________, 

      ___________ आम इंटिनेट खतिे हैं। 

10. ___________ एक ऐसा प्र ग्राम है    दुभाथवनापूणथ प्र ग्राम  ैसे वायिस का पता लगाता है 

औि हमें प्र  ेर किता है। 

11.  िेटा क  रिस्ट ि औि रिकवि किने के जलए उपय ग जकए  ाने वाले िेटा की कॉपी कहलाती है 

ए) एंटीवायिस   बी) बैकअप   सी) फायिवॉल 

12.  अपना ________ दूसिे के सार् साझा न किें  

ए) न ट्स      बी) पासविथ    सी) न टबुक 

13.  इंटिनेट सुिक्षा के जलए उपय ग की  ाने वाली कुछ सवोत्तम प्रर्ाओं क  जलखें। 

14.  कुछ आम इंटिनेट च िी की सूची बनाएं। 

15. निम्िभिखित में से कौि-सी आपातकािीि ष्स्थनतयााँ हैं? 
a) मोच b) धगरिा c) िूकंप d) दो वाहिों की टतकर 

16. निम्िभिखित में से कौि-सी द घाटिाएाँ हैं? 
 ए) स्पिे बी) रासायनिक ररसाव सी) िूकंप िी) आपात ष्स्थनत 

 



 

17. _____________ वह ष्स्थनत है जो तत्काि जोखिम का कारण बिती है और ष्जस पर तत्काि     

 ध्याि  देिे की आवश्यकता है। 
a) द घाटिा b) आपात ष्स्थनत c) धगरिा d) ितरा 

18. आग िगिे की ष्स्थनत में कमाचाररयों को आपातकािीि निकासी और स रक्षा के बारे में भशक्षक्षत  

 करिे का सबसे अच्छा तरीका है ________________ 
ए) फायर डिि आयोष्जत करिा बी) कमाचाररयों को प्रभशक्षण देिा 
सी) सिी कमाचाररयों को आग से बचाव की योजिाएाँ उपि्ध करािा। 

    र्ी )  उपरोतत सिी 
19. आपकी घरेिू प्राथभमक धचककत्सा ककट में इिमें से ककसे शाभमि करिा चाटहए? 

ए) हाइिोजि पेरोतसाइि बी) कैिामाइि िोशि सी) एष्स्पररि िी) ये सिी 
20. िारत में फायर इमरजेंसी िबंर तया है? 

ए) 100 बी) 102 सी) 101 िी) 911 
             21.___________ वास्तपवक धचककत्सा सहायता आिे से पहिे ककसी बीमारी या चोट के भिए प्राथभमक      

धचककत्सा प्रनतकिया को संदभिात करता है 
ए) उपचार बी) प्राथभमक धचककत्सा सी) घाव की सफाई िी) सीपीआर 

 

Competency based Question: 

1. मलण को यात्रा करना पसंद है वह ब्लॉग बनाना चाहती है। क्रदए गए बॉक्स में उसे सुझाव दें क्रक वह क्रकस प्रकार के 

ब्लॉग बना सकती है। 
2. सुमी ब्लॉगर बनना चाहती हैं। क्या वह ब्लॉलगंग से कमा सकती है? 
3. राज ब्लॉग अकाउंट के ललए पासवडा सेट करना चाहता है। मजबूत पासवडा के ललए आवश्यक उल्लेख करके उसकी 

सहायता करें। 
4.  अलमत ब्लॉग ललखना चाहता है। उसकी क्या आवश्यकताएं होनी चालहए?

 
 

5.रीना के पास सीलमत इंटरनेट कनेक्शन है। उसे सुझाव दें क्रक उसे क्रकस प्रकार का ब्लॉग लेखन अपनाना चालहए। 

BLOG -
REQUIREMENTS 

___________
___________

_

_________
_________



6. अनु यूट्यूब चैनल पर एक ररपोटार है उसे िैशन इवेंट को लाइव कवर करना है। वह कौन सा ब्लॉग पसंद करेगी और क्यों? 
7. पररधध एक स्कूि यात्रा पर जा रही है जहााँ उसे छात्रों के एक समूह का प्रनतनिधध बिाया गया है। छात्रों को 
इस बारे में प्रभशक्षण टदया गया है कक ककसी द घाटिा की ष्स्थनत में तया करिा चाटहए, आपके पवचार से छात्रों 
को निम्िभिखित में से तया बताया जािा चाटहए था? 
a) द घाटिा होिे पर त रंत पररवार को सूधचत करें। 
बी) एभसि के मामिे में 
त रंत प भिस के रूप में ईएिटी। 
ग) द घाटिा होिे पर एम्ब िेंस और प भिस को सूधचत करें; दसूरों को सूधचत करते समय 3P का पािि करें। 
d) राटरपनत के मामिे में उन्हें अस्पतािों में जािे के भिए टैतस ब क करिा चाटहए। 
उिर: द घाटिा की ष्स्थनत में एंब िेंस और प भिस को सूधचत करें; दसूरों को सूधचत करते समय 3P का पािि 
करें। 
8. म टिका एक सतका  िडकी है और स्कूि में आयोष्जत पवभिन्ि कायाशािाओं में उत्साह से िाग िेती है। हाि 
ही में उसिे एक कायाशािा में िाग भिया कक आपातकािीि जीवि ष्स्थनतयों में तया करिा चाटहए, वह वहां 
तया सीि सकती थी? 
a) एक स्कूि आपात ष्स्थनत में च प रहता है। 
ि) व्यष्तत को प्राथभमक धचककत्सा तैयार रििी चाटहए। 
ग) प भिस को फोि करिा चाटहए। 
घ) सतका  रहिा चाटहए और उन्हें पता होिा चाटहए कक अिामा कैसे बजािा है; स रक्षक्षत स्थाि पर पह ाँचते समय 
आपातकािीि सेवा से संपका  करें सिी को सहयोग करिा चाटहए और घबरािा िहीं चाटहए 
उिर: पवकल्प (िी) 
  



 
 

Subjective Questions: 

जनम्नजलस्खत का उत्ति दें :- 

 

1. आईएसपी को समझ इए। 

2. नेटिगकिं ि के ल भ बत इए। 
3. नेटिकक  के प्रक रोां को पररभ गित कीगजए। 

4. फुल फॉमक गलखें 

1.www 2. आईएसपी 3. पैन। 4. िैन। 5. पी2पी. 6. लैन 

5. मोरे्म को पररभ गित कीगजए। 

6. झटपट संदेश  ंसे आप क्या समझते हैं? 

7. जकन्ी ंपांच एक्लिकेशन आधारित इंस्टेंट मैसेज ंग सॉफ्टवेयि की सूची बनाएं। 

8.  त्वरित संदेश सेवा की क ई तीन प्रमुख जवशेषताएुँ  दीज ए। 

9.  इंटिनेट पि चैट किते समय जकन्ी ं03 जनयम  ंऔि जशष्टाचाि  ंका पालन किना चाजहए। 

10.  इंस्टेंट मैसेज ंग (चैट) सॉफ्टवेयि का उपय ग किने के जलए बुजनयादी  रूितें क्या हैं। 

11. "ऑफ़लाइन ब्लॉग अलधक लोकलप्रय हैं" कथन का समथान करने के ललए कारण दें। 

12.  क्रदए गए बॉक्स में क्रकन्हीं 3 ऑिलाइन ब्लॉग के नाम बताएं- 

 

 

13. ब नियादी निकासी योजिा तया होिी चाटहए? 

14. आपात ष्स्थनतयों और द घाटिाओं के क छ उदाहरण बताइए। 

15. द घाटिाओं से निपटिे के सामान्य तरीके तया हैं? 

16. आपात ष्स्थनत के पवभिन्ि प्रकार तया हैं? 

17. कायास्थि के क छ ितरों के िाम बताएं। 

18. कायाािय की स रक्षा की ष्जम्मेदारी ककसके पास होती है? 

19. प्राथभमक धचककत्सा तया है? इसका तया महत्व है? 

20. कायााियों में स रक्षा स निष्श्चत करिे के भिए क छ सामान्य नियमों और टदशानिदेशों की सूची बिाएं। 



21. कायाािय द घाटिाओं के क छ कारण तया हैं? 

22. क छ पवद्य त स रक्षा नियमों की सूची बिाएं। 
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